


November 29, 2005

1

             Adobe Acrobat Reader 5.0

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF 
document.  Acrobat Reader looks for the word by reading every word on every page in the file, 
including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.
2. Enter the text to find in the text box.
3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in 
the box.  For example, if you search for the word stick, the words tick and sticky will 
not be highlighted.
Match Case finds only words that contain exactly the same capitalization you enter in 
the box.
Find Backwards starts the search from the current page and goes backwards through 
the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.
       To find the next occurrence of the word: 
        Do one of the following:
        Choose Edit > Find Again 
        Reopen the find dialog box, and click Find Again.  (The word must already be in the         
Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it 
into another application such as a word processor.  You can also paste text into a PDF 
document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you 
can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the 
copied text, the font cannot be preserved.  A default font  is substituted.
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To select and copy it to the clipboard:
1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to the last 
letter.  
       To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or 
Option (Mac OS) as you drag across the width of the document. 
       To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or 
Option+Command (Mac OS) as you drag the length of the document.
        To  select all the text on the page, choose Edit > Select All.  In single page mode, all the 
text on the current page is selected.  In Continuous or Continuous – facing mode, most of the 
text in the document is selected.  When you release the mouse button, the selected text is 
highlighted.  To deselect the text and start over, click anywhere outside the selected text.  
The Select All command will not select all the text in the document.  A workaround for this 
(Windows) is to use the Edit > Copy command.  

2. Choose Edit > Copy to copy the selected text to the clipboard.
3. To view the text, choose Window > Show Clipboard
In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the 
Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose 
Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows 
Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.
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1 [REPORT OF ACTION TAKEN IN CLOSED SESSION

2 ON NOVEMBER 29, 2005, BEGINS ON PAGE 78.]

3

4

5

6 SUP. ANTONOVICH: SUPERVISORS, WE'RE GOING TO BEGIN WITH PRAYER 

7 AND THEN THE PLEDGE OF ALLEGIANCE AND THEN WE'RE GOING TO HAVE 

8 A SPECIAL ACTION AS A RESULT OF AN ADMINISTRATIVE PROBLEM THAT 

9 OCCURRED IN THE REGISTRAR-RECORDER'S OFFICE SO THAT, PRIOR TO 

10 10:00, WE CAN TAKE ACTION ON CERTIFICATION OF THE ELECTION 

11 RESULTS BECAUSE, AT 10:00 THROUGHOUT THIS COUNTY AND A NUMBER 

12 OF OUR CITIES, ELECTED OFFICIALS FROM MAYORS, SCHOOL BOARD 

13 MEMBERS ARE BEING SWORN IN AND THEN WE'LL MAKE THE 

14 PRESENTATION TO THE PLEDGE OF ALLEGIANCE REPRESENTATIVE FROM 

15 THE AMERICAN LEGION WITH HIS PROCLAMATION. SO WE WILL CALL THE 

16 MEETING TO ORDER AND SUPERVISOR DON KNABE WILL LEAD US IN 

17 PRAYER AND THEN WE'LL DO THE PLEDGE. 

18

19 SUP. KNABE: IF YOU WILL JOIN ME IN AN ATTITUDE OF PRAYER, 

20 PLEASE. OUR MOST KIND AND GRACIOUS HEAVENLY FATHER, WE COME 

21 BEFORE YOU ONCE AGAIN THIS MORNING TO THANK YOU FOR THE 

22 BOUNTIFUL BLESSINGS YOU'VE BESTOWED UPON EACH OF US. AS WE 

23 HAVE CELEBRATED THE HOLIDAY OF THANKSGIVING AND ENJOYED THOSE 

24 DAYS TOGETHER WITH FAMILY AND FRIENDS, WE ARE ALSO VERY AWARE 

25 OF THOSE THAT WERE WITHOUT. AND AS WE BEGIN A CELEBRATION OF 
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1 THE HOLIDAY SEASON, AT THE TIME OF JOY-- IT'S A TIME OF JOY 

2 FOR EVERYONE, FOR FAMILY, FRIENDS BUT IT'S ALSO A TIME OF NEED 

3 FOR EVERYONE AND WE WOULD JUST ASK YOUR BLESSINGS OVER THOSE 

4 THAT, WE AS A COMMUNITY AND A COUNTY, CAN COME TOGETHER TO 

5 ASSIST THOSE IN NEED. AND, GOD, WE JUST ASK YOUR BOUNTIFUL 

6 PRAYER AND BLESSINGS OVER THIS GATHERING TODAY AND OUR MEETING 

7 AND OUR BUSINESS OF THE DAY, NOT ONLY THAT WE TRY TO DO THE 

8 RIGHT THING BUT WE DO THE GOOD THING. AND WE ASK YOUR 

9 CONTINUED BLESSINGS AND ALL GOD'S PEOPLE SAID AMEN. 

10

11 KIM DEBERRY: WOULD YOU PLACE YOUR HAND OVER YOUR HEART AND 

12 JOIN ME IN THE PLEDGE OF ALLEGIANCE? [ PLEDGE OF ALLEGIANCE ] 

13

14 SUP. ANTONOVICH: WE'LL CALL EXECUTIVE OFFICE AND THEN WE'LL 

15 ASK COUNTY COUNSEL TO GIVE US THE AUTHORIZATION AND 

16 RECOMMENDATION. AND THEN SUPERVISOR BURKE CAN MAKE HER 

17 PRESENTATION. 

18

19 CLERK ROBIN GUERRERO: OKAY, WE HAVE JUST RECEIVED THIS MORNING 

20 THE OFFICIAL ELECTIONS RESULTS FROM THE REGISTRAR-

21 RECORDER/COUNTY CLERK. IN ORDER THAT THESE ELECTION RESULTS 

22 CAN BE CERTIFIED, IT WOULD BE APPROPRIATE FOR THE BOARD TO 

23 TAKE THE FOLLOWING ACTION: MAKE A FINDING THAT THE OFFICIAL 

24 RESULTS OF THE ELECTION AND RECOMMENDATION OF THE REGISTRAR-

25 RECORDER/COUNTY CLERK CERTIFYING THOSE RESULTS CAME TO THE 
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1 ATTENTION OF THE BOARD LESS THAN 72 HOURS BEFORE THE MEETING 

2 AND THERE IS A NEED TO TAKE IMMEDIATE ACTION FOR APPROVAL OF 

3 THE REGISTRAR-RECORDER/COUNTY CLERK'S RECOMMENDATION TO 

4 DECLARE OFFICIAL THE RESULTS OF THE SPECIAL STATEWIDE AND 

5 CONSOLIDATED ELECTION HELD NOVEMBER 8TH, 2005. IT WOULD BE 

6 APPROPRIATE AT THIS TIME TO MAKE A MOTION. 

7

8 SUP. ANTONOVICH: OKAY. COUNSEL, THEN, WE HAVE FOUR MEMBERS, 

9 BECAUSE IT'S NOT ON THE AGENDA, WE CAN TAKE ACTION TO APPROVE 

10 THIS ITEM? 

11

12 RAYMOND G. FORTNER, JR.: YES, MR. CHAIRMAN, YOU CAN. IT IS A 

13 4-VOTE ITEM. 

14

15 SUP. ANTONOVICH: OKAY. MOTION BY BURKE. SECONDED. WITHOUT 

16 OBJECTION, SO ORDERED. OKAY. LET US-- SUPERVISOR KNABE WILL 

17 GIVE A PRESENTATION TO MR. KIM DEBERRY, WHO LED US IN THE... 

18

19 SUP. KNABE: YES, I'D LIKE TO ASK KIM TO JOIN ME OVER HERE. KIM 

20 DEBERRY IS A MEMBER OF THE AMVETS POST NUMBER 48 IN LONG 

21 BEACH. HE SERVED IN THE MILITARY FROM 1979 TO 1981 AS A PETTY 

22 OFFICER THIRD CLASS IN THE UNITED STATES NAVY ASSAULT CRAFT 

23 UNIT 2 IN NORFOLK, VIRGINIA. HIS DECORATIONS ARE THE NAVY GOOD 

24 CONDUCT MEDAL, NAVY EXPEDITIONARY MEDAL AND THE NATIONAL 

25 DEFENSE SERVICE MEDAL. KIM HAS LIVED IN THE FOURTH DISTRICT 
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1 FOR SOME FOUR YEARS AND, MOST IMPORTANTLY, HE WORKS AT HARBOR 

2 UCLA AS A CHEF AT THE HOSPITAL, SO WE WANT TO THANK YOU FOR 

3 TAKING THE TIME OUT OF YOUR BUSY DAY TO JOIN US HERE AND LEAD 

4 US IN THE PLEDGE OF ALLEGIANCE AND WISH YOU A JOYOUS HOLIDAY 

5 SEASON. [ APPLAUSE ] 

6

7 CLERK ROBIN GUERRERO: MAYOR PRO TEM AND MEMBERS OF THE BOARD, 

8 WE WILL BEGIN ON PAGE 5, AGENDA FOR THE MEETING OF THE 

9 COMMUNITY DEVELOPMENT COMMISSION OF THE COUNTY OF LOS ANGELES, 

10 ITEM 1-D. 

11

12 SUP. ANTONOVICH: SUPERVISOR KNABE MOVES, SECONDED. WITHOUT 

13 OBJECTION, SO ORDERED. 

14

15 CLERK ROBIN GUERRERO: AGENDA FOR THE MEETING OF THE HOUSING 

16 AUTHORITY OF THE COUNTY OF LOS ANGELES, ITEM 1-H. WE HAVE A 

17 REQUEST TO HOLD THAT ITEM FOR SUPERVISOR ANTONOVICH. BOARD OF 

18 SUPERVISORS, ITEMS 1 THROUGH 10. THEY ARE BEFORE YOU. 

19

20 SUP. ANTONOVICH: MOTION BY YAROSLAVSKY. SECONDED. WITHOUT 

21 OBJECTION, SO ORDERED. 

22

23 CLERK ROBIN GUERRERO: ADMINISTRATIVE OFFICER, ITEMS 11 THROUGH 

24 14. 

25
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1 SUP. ANTONOVICH: MOTION BY BURKE. SECONDED. WITHOUT OBJECTION, 

2 SO ORDERED. 

3

4 CLERK ROBIN GUERRERO: BEACHES AND HARBORS, ITEMS 15 AND 16. WE 

5 HAVE A REQUEST FROM SUPERVISOR KNABE TO CONTINUE ITEM 15 FOR 

6 TWO WEEKS TO DECEMBER 13TH, 2005. ITEM 16 IS BEFORE YOU AT 

7 THIS TIME. 

8

9 SUP. KNABE: MOVE IT. 

10

11 SUP. ANTONOVICH: MOTION BY KNABE, SECONDED, FOR CONTINUANCE 

12 FOR TWO WEEKS. WITHOUT OBJECTION, SO ORDERED APPROVAL ON ITEM 

13 16. 

14

15 SUP. KNABE: MOVE APPROVAL FOR ITEM 16. 

16

17 CLERK ROBIN GUERRERO: CHIEF INFORMATION OFFICE, ITEM NUMBER 

18 17. 

19

20 SUP. ANTONOVICH: MOTION BY YAROSLAVSKY. SECONDED. WITHOUT 

21 OBJECTION, SO ORDERED. 

22

23 CLERK ROBIN GUERRERO: CHILDREN AND FAMILY SERVICES, ITEMS 18 

24 AND 19. WE HAVE A REQUEST ON NUMBER 18 FOR A MEMBER OF THE 

25 PUBLIC TO HOLD THIS ITEM. 
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1

2 SUP. ANTONOVICH: OKAY. 19 AND 20 BY BURKE. SECONDED. WITHOUT 

3 OBJECTION, SO ORDERED. 

4

5 CLERK ROBIN GUERRERO: 20 WAS COMMUNITY DEVELOPMENT COMMISSION. 

6

7 SUP. ANTONOVICH: EXCUSE ME. JUST ON 19, THAT WAS SO ORDERED. 

8

9 CLERK ROBIN GUERRERO: 20 IS BEFORE YOU FOR THE COMMUNITY 

10 DEVELOPMENT COMMISSION. 

11

12 SUP. ANTONOVICH: MOTION BY KNABE. SECONDED ON 20. WITHOUT 

13 OBJECTION, SO ORDERED. 

14

15 CLERK ROBIN GUERRERO: DISTRICT ATTORNEY, ITEM 21. 

16

17 SUP. ANTONOVICH: MOTION BY YAROSLAVSKY. SECONDED. WITHOUT 

18 OBJECTION, SO ORDERED. 

19

20 CLERK ROBIN GUERRERO: HEALTH SERVICES, ITEMS 22 THROUGH 38. WE 

21 HAD ON THE GREEN SUPPLEMENTAL AGENDA, ITEM 22 TO BE REFERRED 

22 BACK TO THE DEPARTMENT. HOWEVER, IT'S COME TO OUR ATTENTION 

23 THIS MORNING THAT THE DIRECTOR OF HEALTH SERVICES IS 

24 REQUESTING THAT ITEM 22 BE CONTINUED FOR ONE WEEK. ITEM NUMBER 

25 26, CONTINUE ONE WEEK FOR SUPERVISOR BURKE. AND ITEM 29, 
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1 CONTINUE ONE WEEK FOR SUPERVISOR BURKE. AND THE REST ARE 

2 BEFORE YOU. YES. 22, CONTINUE ONE WEEK FOR THE DIRECTOR OF 

3 HEALTH SERVICES. 26, CONTINUE ONE WEEK FOR SUPERVISOR BURKE. 

4 29, CONTINUE ONE WEEK FOR SUPERVISOR BURKE. 

5

6 SUP. ANTONOVICH: WHAT ABOUT ITEM 32? 

7

8 CLERK ROBIN GUERRERO: AND ITEM 32, CONTINUE ONE WEEK FOR THE 

9 DIRECTOR OF HEALTH SERVICES. 

10

11 SUP. ANTONOVICH: OKAY. MOTION BY BURKE, SECONDED. WITHOUT 

12 OBJECTION, SO ORDERED. 

13

14 CLERK ROBIN GUERRERO: ON INTERNAL SERVICES, ITEMS 39 AND 40. 

15 ITEM 39, WE HAVE A REQUEST TO HOLD THAT ITEM BY SUPERVISOR 

16 ANTONOVICH. AND ITEM 40 IS BEFORE YOU. 

17

18 SUP. ANTONOVICH: OKAY. MOTION BY YAROSLAVSKY. SECONDED. 

19 WITHOUT OBJECTION, SO ORDERED. 

20

21 CLERK ROBIN GUERRERO: MENTAL HEALTH, ITEMS 41 AND 42. 

22

23 SUP. ANTONOVICH: MOTION BY BURKE. SECONDED. WITHOUT OBJECTION, 

24 SO ORDERED. 

25
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1 CLERK ROBIN GUERRERO: PUBLIC SOCIAL SERVICES, ITEMS 43 THROUGH 

2 44. 

3

4 SUP. ANTONOVICH: MOTION BY KNABE. SECONDED. WITHOUT OBJECTION, 

5 SO ORDERED. 

6

7 CLERK ROBIN GUERRERO: PUBLIC WORKS, ITEMS 45 THROUGH 69. 

8

9 SUP. ANTONOVICH: MOTION BY YAROSLAVSKY. SECONDED. WITHOUT 

10 OBJECTION, SO ORDERED. 

11

12 CLERK ROBIN GUERRERO: SHERIFF, ITEM 70 AND 71. 

13

14 SUP. ANTONOVICH: MOTION BY BURKE. SECONDED. WITHOUT OBJECTION, 

15 SO ORDERED. 

16

17 CLERK ROBIN GUERRERO: ON ITEM 72, WE HAVE A REQUEST TO HOLD 

18 THAT ITEM BY SUPERVISOR KNABE AND ALSO I HAVE A REQUEST FROM 

19 SUPERVISOR YAROSLAVSKY TO APPROVE THE SETTLEMENT AND CONTINUE 

20 FOR 30 DAYS THE CORRECTIVE ACTION PLAN PORTION. 

21

22 SUP. YAROSLAVSKY: 30 DAYS OR-- THAT'S NOT A BOARD DAY. LET'S 

23 DO IT FOR TWO WEEKS ON THE CORRECTIVE ACTION PLAN AND THEN IF 

24 WE NEED MORE TIME, WE'LL... 

25
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1 SUP. KNABE: I DON'T HAVE A PROBLEM WITH THAT, BECAUSE MY 

2 QUESTIONS, THE REASON FOR HOLDING WAS ON THE CORRECTIVE 

3 ACTION. 

4

5 CLERK ROBIN GUERRERO: SO WE WOULD APPROVE THE SETTLEMENT AND 

6 CONTINUE THE CORRECTIVE ACTION PLAN FOR TWO WEEKS. 

7

8 SUP. KNABE: OKAY, I'LL SECOND THAT. 

9

10 SUP. ANTONOVICH: OKAY, MOTION BY YAROSLAVSKY. SECONDED BY 

11 KNABE. WITHOUT OBJECTION, SO ORDERED. 

12

13 CLERK ROBIN GUERRERO: AND THAT INCLUDES ALL THE OTHER ITEMS 

14 FOR APPROVAL. 

15

16 SUP. ANTONOVICH: YES. 

17

18 CLERK ROBIN GUERRERO: OKAY. EXCUSE ME. ON ITEM 79, WE HAVE A 

19 REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THAT ITEM. 

20

21 SUP. ANTONOVICH: SO ITEM-- MOTION BY YAROSLAVSKY, SECONDED BY 

22 BURKE TO RECONSIDER 79. WITHOUT OBJECTION, SO ORDERED. WE'LL 

23 HOLD 79 FOR THE PUBLIC. 

24
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1 CLERK ROBIN GUERRERO: ORDINANCES FOR ADOPTION, ITEMS 80 AND 

2 81. 

3

4 SUP. ANTONOVICH: MOTION BY BURKE. SECONDED. WITHOUT OBJECTION, 

5 SO ORDERED. 

6

7 CLERK ROBIN GUERRERO: WE HAVE PUBLIC HEARINGS, 82 THROUGH 84. 

8 WE WILL HOLD THOSE FOR-- TO CONDUCT THE HEARINGS. ITEM 85, 

9 ADDITIONS TO THE AGENDA REQUESTED BY BOARD MEMBERS AND THE 

10 CHIEF ADMINISTRATIVE OFFICER WHICH WERE POSTED MORE THAN 72 

11 HOURS IN ADVANCE OF THE MEETING, AS INDICATED ON THE GREEN 

12 SUPPLEMENTAL AGENDA. WE HAVE AGENDA ITEM 85-A. WE HAVE A 

13 REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THAT ITEM. AND 

14 THAT COMPLETES THE READING OF THE AGENDA. BOARD OF SUPERVISORS 

15 SPECIAL ITEMS BEGIN WITH SUPERVISORIAL DISTRICT NUMBER 3. 

16

17 SUP. ANTONOVICH: BEFORE WE DO THAT, WE HAVE CONSUL GENERAL 

18 TO... 

19

20 CLERK ROBIN GUERRERO: EXCUSE ME, WE HAVE-- I'M SORRY. ALSO, WE 

21 HAVE A REQUEST FROM A MEMBER OF THE PUBLIC UNDER ITEM A-3, 

22 ITEMS CONTINUED FROM PREVIOUS MEETINGS FOR FURTHER DISCUSSION 

23 AND ACTION BY THE BOARD, TO HOLD A-3. 

24
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1 SUP. ANTONOVICH: OKAY. THIS MORNING WE'RE GOING TO WELCOME TO 

2 THE COUNTY OF LOS ANGELES BOLIVIA'S NEW CONSUL-GENERAL, THE 

3 HONORABLE FERNANDO LAZCANO TO OUR COUNTY. HE WAS ACCREDITED BY 

4 THE UNITED STATES STATE DEPARTMENT ON APRIL 25TH OF THIS YEAR. 

5 A NATIVE OF BOLIVIA, HE JOINED THE BOLIVIAN FOREIGN SERVICE IN 

6 1982. HE'S HELD VARIOUS POSITIONS, INCLUDING DEPUTY CONSUL-

7 GENERAL IN MIAMI, FLORIDA. HE STUDIED LANGUAGES AT THE 

8 UNIVERSITY OF MUNICH IN GERMANY, HOLDS A DEGREE IN 

9 INTERNATIONAL RELATIONS FROM INSTITUTE OF RESEARCH AND 

10 INTERNATIONAL RELATIONS FROM FLORENCE, ITALY. WE ARE VERY 

11 PLEASED TO WELCOME YOU, CONSUL. WE HAVE OVER, AS YOU KNOW, 90 

12 CONSUL-GENERALS REPRESENTING THEIR COUNTRIES IN OUR COUNTY AND 

13 WE HAVE A VERY DYNAMIC COUNTY WHERE BASICALLY IT'S A UNITED 

14 NATIONS, WHERE EVERY CITIZEN OF THE WORLD HAS A RELATIVE 

15 LIVING HERE AND MANY OF THEM HAVE GOVERNMENTS OF THEIR NATIVE 

16 COUNTRIES POSTED HERE AS WELL. SO, CONSUL-GENERAL, WELCOME TO 

17 OUR COUNTY. WE LOOK FORWARD TO WORKING WITH YOU. OUR SHERIFF 

18 IS DIRECTLY INVOLVED WITH YOU AS OUR PROTOCOL OFFICE AND OUR 

19 BOARD, WE WELCOME YOU AND LOOK FORWARD TO WORKING WITH YOU. [ 

20 APPLAUSE ] 

21

22 THE HONORABLE CONSUL-GENERAL FERNANDO LAZCANO: GOOD MORNING, 

23 LADIES AND GENTLEMEN. I'VE PREPARED SOMETHING SMALL PIECE LIKE 

24 _________________ OF _________________ SO HOPE YOU DON'T GET 

25 BORED WITH THIS. IT IS AN HONOR FOR ME TO BE HERE THIS MORNING 
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1 AT THE OFFICE OF THE COUNTY BOARD OF SUPERVISORS WITH THE 

2 HONORABLE MICHAEL ANTONOVICH, YVONNE BURKE, DON KNABE AND ZEV 

3 YAROSLAVSKY, WHO HAVE CORDIALLY INVITED ME FOR THIS 

4 PRESENTATION AS THE NEWLY APPOINTED CONSUL-GENERAL OF BOLIVIA 

5 IN THIS GREAT CITY. FIRST, I WOULD LIKE TO EXPRESS MY SINCERE 

6 GRATITUDE TO ALL THE SUPERVISORS AND I SEND MY WARMEST REGARDS 

7 TO THE AUDIENCE PRESENT HERE TODAY. AFTER MORE THAN TWO 

8 DECADES, MY GOVERNMENT HAS DECIDED TO REOPEN THE OFFICE OF THE 

9 CONSUL-GENERAL HERE IN LOS ANGELES FOR SEVERAL IMPORTANT 

10 REASONS. FIRST, THE BOLIVIAN COMMUNITY HAS RECENTLY BEEN 

11 GROWING IN SOUTHERN CALIFORNIA DUE TO THE FACT THAT THIS 

12 WONDERFUL STATE REPRESENTS ONE OF THE LARGEST ECONOMIES IN THE 

13 WORLD AND HAS BECOME A FOCAL POINT FOR VARIOUS BOLIVIAN 

14 ENTREPRENEURS, LEADING TO STRONG COMMERCIAL TIES AS WELL AS 

15 THE DEVELOPMENTAL OF TRADE AND CULTURAL EXCHANGE. IN ADDITION, 

16 BOLIVIA HAS THE LARGEST MINERAL RESERVE OF NATURAL GAS IN THE 

17 REGION, WHICH EXCEEDS APPROXIMATELY 56 TRILLION CUBIC FEET. 

18 THE POSSIBILITIES ARE SUBSTANTIAL ONCE THE HYDROCARBON LAWS 

19 ARE PUT INTO PLACE. WHEN THIS OCCURS, IT IS BOLIVIA'S 

20 INTENTION TO EXPORT NATURAL GAS TO CALIFORNIA, WHICH WOULD BE 

21 BENEFICIAL TO BOTH COUNTRIES. THANK YOU ONCE AGAIN FOR 

22 ALLOWING ME TO SERVE WITH YOU. [ APPLAUSE ] 

23

24 SUP. YAROSLAVSKY: I'D LIKE TO CALL UP DR. JONATHAN FIELDING. 

25 IS DR. FIELDING HERE? AND MARIO PEREZ, BETTY D'AUGUSTINE AND 
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1 RICKIE ROSALES. MEMBERS OF THE BOARD, THIS PROCLAMATION TODAY 

2 IS FOR WORLD A.I.D.S. DAY AND ASKS THE COUNTY OF LOS ANGELES 

3 TO PROCLAIM DECEMBER 1ST, 2005, THIS THURSDAY, AS WORLD 

4 A.I.D.S. DAY. AN ESTIMATED 57,000 PERSONS ARE LIVING WITH 

5 H.I.V./A.I.D.S. IN LOS ANGELES COUNTY ALONE. 85% OF A.I.D.S. 

6 CASES CONTINUE TO BE AMONG GAY AND BISEXUAL MEN AND AN 

7 ESTIMATED 75% OF ALL NEW CASES OF H.I.V. INFECTIONS OCCUR 

8 AMONG PEOPLE OF COLOR. AND THUS THERE ARE NOW MORE LATINOS 

9 LIVING WITH A.I.D.S. IN LOS ANGELES COUNTY THAN ANY OTHER 

10 RACIAL OR ETHIC GROUP, AND AFRICAN-AMERICAN WOMEN AND MEN ALSO 

11 CONTINUE TO BE DISPROPORTIONATELY AFFECTED IN THIS COUNTY BY 

12 THE VIRUS. WORLD A.I.D.S. DAY PROVIDES AN OPPORTUNITY TO FOCUS 

13 ATTENTION ON H.I.V. INFECTION AND A.I.D.S. AND TO CONTINUE 

14 POLICY COMMITMENTS TO ADDRESS THE H.I.V./A.I.D.S. PANDEMIC AND 

15 TO REACH OUT TO THOSE AT RISK FOR INFECTION AND RENEW OUR 

16 EFFORTS TO PREVENT THE SPREAD OF H.I.V. THROUGH EDUCATION AND 

17 FOCUS PREVENTION PROGRAMS AND TO PROVIDE TREATMENT AND CARE TO 

18 THOSE IN NEED. THE WORLD A.I.D.S. DAY 2005 THEME, "STOP 

19 A.I.D.S., KEEP THE PROMISE," REMINDS GOVERNMENT LEADERS AT A 

20 LOCAL, NATIONAL, AND INTERNATIONAL LEVEL OF THEIR OBLIGATIONS 

21 TO STAY UNITED IN URGENT ACTION TO STOP THE SPREAD OF H.I.V. 

22 AND A.I.D.S. AND TO INCREASE OUR UNDERSTANDING AND COMPASSION 

23 FOR THOSE LIVING WITH H.I.V. AND A.I.D.S. AND TO HONOR THE 

24 COMMITMENT TO STOP H.I.V. INFECTION AND A.I.D.S. SO THEREFORE 

25 BE IT RESOLVED THAT THE BOARD OF SUPERVISORS OF THE COUNTY OF 
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1 LOS ANGELES PROCLAIM DECEMBER 1ST, 2005, AS WORLD A.I.D.S. DAY 

2 THROUGHOUT THE COUNTY OF LOS ANGELES AND URGE A RENEWED 

3 COMMITMENT TO ACTION TO ALL LEVELS OF GOVERNMENT AND IN THE 

4 GENERAL POPULATION AGAINST THE DEVASTATION OF H.I.V. 

5 INFECTION. I'M DOING THIS ON BEHALF OF SUPERVISOR MOLINA, WHO 

6 IS NOT HERE TODAY, BUT IT'S A 5-MEMBER SCROLL, ALL FIVE OF US 

7 JOIN IN THIS. IT'S AN ISSUE WE LIVE WITH EVERY DAY AS COUNTY 

8 OFFICIALS AND AS HUMAN BEINGS, SO I WANT TO JUST ASK DR. 

9 FIELDING TO ACCEPT THIS, ASK ALL OF YOU TO ACCEPT THIS AND TO 

10 SAY A COUPLE OF WORDS. 

11

12 DR. JONATHAN FIELDING: THANK YOU VERY MUCH, SUPERVISOR 

13 YAROSLAVSKY AND OTHER BOARD MEMBERS. THANKS FOR YOUR TIRELESS 

14 SUPPORT OF OUR EFFORTS TO REDUCE THIS TERRIBLE EPIDEMIC. TWO 

15 IMPORTANT FACTS: WE HAVE MORE PEOPLE IN LOS ANGELES COUNTY 

16 LIVING WITH H.I.V. AND A.I.D.S. TODAY THAN EVER BEFORE. THIS 

17 IS A PROBLEM THAT'S NOT GOING AWAY, IT'S GETTING BIGGER AND SO 

18 WE HAVE TO REDOUBLE OUR EFFORTS TO TRY AND REDUCE THE TOLL OF 

19 THIS TERRIBLE SCOURGE. AND, SECONDLY, DESPITE WONDERFUL 

20 EFFORTS FROM A LOT OF COMMITTED PEOPLE, WE HAVE NOT SEEN A 

21 REDUCTION IN THE NUMBER OF NEW H.I.V. CASES. IT REINFORCES THE 

22 IMPORTANCE OF PREVENTION, IT REINFORCES THE IMPORTANCE OF 

23 TESTING AND COUNSELING AND FOCUSING ON OUR VARIOUS 

24 COMMUNITIES, BECAUSE THE COMMUNITIES OF COLOR ARE 
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1 DISPROPORTIONATELY AFFECTED. THANKS AGAIN FOR YOUR SUPPORT. [ 

2 APPLAUSE ] 

3

4 SPEAKER: JUST A FEW WORDS. ON BEHALF OF THE L.A. COUNTY H.I.V. 

5 PREVENTION PLANNING COMMITTEE AND ALL THE COMMUNITIES THAT WE 

6 SERVE, THANK YOU VERY MUCH FOR YOUR CONTINUED SUPPORT ON 

7 ISSUES CONCERNING H.I.V. AND A.I.D.S. THANK YOU. 

8

9 MARIO PEREZ: THANK YOU, SUPERVISOR YAROSLAVSKY AND THE BOARD. 

10 ON BEHALF OF THE 57,000 PEOPLE LIVING WITH H.I.V. OR A.I.D.S. 

11 IN OUR COUNTY AND THE HUNDREDS OF PEOPLE WHO WORK TIRELESSLY 

12 EVERY DAY TO IMPROVE THEIR LIVES, THANK YOU FOR THIS 

13 PROCLAMATION. THIS YEAR'S THEME, "STOP A.I.D.S., KEEP THE 

14 PROMISE", CALLS ON ALL OF US, ESPECIALLY LEADERS IN 

15 GOVERNMENT, TO SUPPORT OUR REINVIGORATED, RENEWED, EFFECTIVE, 

16 SUSTAINED RESPONSE TO THE LOCAL A.I.D.S. EPIDEMIC. SO, ONCE 

17 AGAIN, THANK YOU VERY MUCH FOR YOUR SUPPORT. [ APPLAUSE ] 

18

19 SUP. YAROSLAVSKY: I GUESS, MR. KNABE, YOU'RE NEXT. 

20

21 SUP. KNABE: THANK YOU, MR. YAROSLAVSKY. LAST SPRING, THE 

22 CHILDREN'S LAW CENTER SPEARHEADED THE ANNUAL FOSTER CARE 

23 AWARENESS CAMPAIGN, WHICH SEEKS TO BRING PUBLIC ATTENTION TO 

24 TREMENDOUS NEED FOR AWARENESS OF AND COMMUNITY SUPPORT FOR THE 

25 CHILDREN IN OUR FOSTER CARE SYSTEM. TODAY, I WANTED TO FOCUS 
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1 ON A VERY SPECIAL PART OF THAT CAMPAIGN. I HAVE HERE WITH ME A 

2 COPY OF AN EXTRAORDINARY COLLECTION OF ARTWORK AND POETRY 

3 CREATED BY FOSTER KIDS CALLED "THE VOICES OF FOSTER YOUTH." 

4 THIS COLLECTION WAS DISTRIBUTED AS PART OF AN OUTREACH 

5 CAMPAIGN AND IT WAS VERY, VERY MOVING. I FELT THAT IT REALLY 

6 PROVIDED A WINDOW INTO THE EXPERIENCE OF BEING A FOSTER KID 

7 AND ALL THE COMPLEX EMOTIONS AND FEELINGS THAT COME WITH THAT. 

8 I ALSO BELIEVE VERY STRONGLY IN OUR RESPONSIBILITY TO PROVIDE 

9 THESE YOUNG PEOPLE WITH AN OPPORTUNITY TO EXPRESS THEMSELVES 

10 ARTISTICALLY, BE IT THROUGH THE FINE ARTS, CREATIVE WRITING, 

11 THEATER, MUSIC OR DANCE. I WAS IMPRESSED TO LEARN THAT THESE 

12 YOUNG ARTISTS, WHOSE WORK IS FEATURED IN THIS PUBLICATION, 

13 WENT THROUGH VARIOUS WORKSHOPS, THEN WERE MENTORED BY TWO 

14 PROFESSIONAL ARTISTS WHO HELPED THE KIDS HONE THEIR ARTISTIC 

15 VISIONS. I HAVE HERE WITH ME TODAY MIRIAM KRINSKI, EXECUTIVE 

16 DIRECTOR OF THE CHILDREN'S LAW CENTER, ALSO WITH SHARON APPLE, 

17 ALSO OF THE CHILDREN'S LAW CENTER. THE C.L.C. WAS ONE OF THE 

18 PRIMARY SPONSORS OF THIS GREAT PUBLICATION. THE TWO ARTISTS 

19 RESPONSIBLE FOR HELPING THESE KIDS HONE THEIR VERY ARTISTIC 

20 VISION ARE JUDY BACA AND KERRY MADDEN. UNFORTUNATELY, JUDY 

21 COULDN'T BE WITH US TODAY BUT KERRY IS, AND WE'D LIKE TO THANK 

22 BOTH OF THEM FOR THEIR WORK ON THIS PARTICULAR PROGRAM. WE'D 

23 ALSO LIKE TO GIVE SPECIAL THANKS TO BEN RODRIGUEZ OF CREATIVE 

24 DEVELOPMENT ASSOCIATES WHO HELPED PROVIDE THE LAYOUT AND 

25 PUBLICATION OF THIS GREAT COLLECTION. I THINK WE HAVE COPIES 
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1 FOR MY COLLEAGUES UP HERE AS WELL, TOO, IF WE HAVEN'T GIVEN 

2 THEM ALL OUT ALREADY. WE'RE GOING TO DO SOME PRESENTATIONS BUT 

3 THEN I'D LIKE TO ASK MIRIAM AND DR. SANDERS AS WELL TO SAY A 

4 FEW WORDS AND, ACTUALLY, I WANT TO HAVE KERRY SAY A FEW WORDS 

5 AS WELL, TOO. WE CONGRATULATED HER UPSTAIRS. SO, FIRST OF ALL, 

6 LET'S DO THE CHILDREN'S LAW CENTER. 

7

8 SUP. KNABE: GET EVERYBODY IN HERE. OKAY. START WITH YOU. WHY 

9 DON'T YOU SAY A COUPLE OF WORDS. 

10

11 KERRY MADDEN: I'D LIKE TO THANK YOU FOR HAVING ME HERE TODAY. 

12 I JUST TELL THE KIDS IN THEIR WRITING WORKSHOP THAT THEY'RE 

13 STORY CATCHERS AND STORY TELLERS AND I ENCOURAGE THEM TO 

14 CAPTURE STORIES IN THE WEBS OF THEIR IMAGINATION AND I JUST 

15 REALLY BELIEVE THAT THEY ALL HAVE A VOICE. SO IT'S BEEN A 

16 GREAT JOY TO WORK WITH THESE KIDS. THANK YOU. [ APPLAUSE ] 

17

18 SPEAKER: WELL, THANK YOU, SUPERVISOR KNABE, AND I'D LIKE TO 

19 THANK NICK EPILITO FOR HIS TREMENDOUS SUPPORT AS WELL AS 

20 SUPERVISORS YAROSLAVSKY AND ANTONOVICH WHO, EVERY YEAR, ARE SO 

21 SUPPORTIVE OF THIS MAY AWARENESS EFFORT. WE OFTEN SAY THAT 

22 WHAT WE NEED MOST IS TO SEE THIS SYSTEM THROUGH THE EYES OF 

23 THE CHILDREN WHO, EVERY DAY, LABOR UNDER DAILY CIRCUMSTANCES 

24 THAT NO CHILD TOO OFTEN SHOULD HAVE TO LIVE THROUGH AND YET, 

25 THROUGH NO FAULT OF THEIR OWN, CHILDREN IN FOSTER CARE FIND 
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1 THEMSELVES UNTETHERED FROM EVERYTHING THAT'S FAMILIAR AND PART 

2 OF NORMAL CHILDHOOD EXISTENCE. THERE ARE MANY TIMES THAT WE 

3 FOCUS ON THE TRAGEDIES OR THE FAILURES OF OUR SYSTEM BUT NOT 

4 ENOUGH TIMES THAT WE PAUSE TO FOCUS ON WHAT WORKS RIGHT WITHIN 

5 OUR FOSTER CARE SYSTEM. IN MAY, WE SEEK TO DO THAT AND THIS 

6 WONDERFUL CREATIVE PROJECT IS REALLY AN ATTEMPT TO LOOK AT THE 

7 SYSTEM THROUGH THE EYES OF THE RESILIENCE AND THE CREATIVITY 

8 AND THE STRENGTH THAT THESE CHILDREN HAVE AND IT'S BEEN A 

9 WONDERFUL PROJECT AND WE ARE SO GRATEFUL TO KERRY MADDEN AND 

10 JUDY BACA FOR THEIR SUPPORT OF BRINGING OUT THAT CREATIVITY 

11 AND RESILIENCE. SO THANK YOU ALL WHO HAVE SUPPORTED THIS 

12 EFFORT AND WHO DO SUCH GREAT WORK EVERY DAY AND EVERY WEEK AND 

13 EVERY MONTH ON BEHALF OF THE CHILDREN IN OUR FOSTER CARE 

14 SYSTEM. [ APPLAUSE ] 

15

16 DR. DAVID SANDERS: I WANT TO THANK SUPERVISOR KNABE AND THE 

17 BOARD OF SUPERVISORS FOR THE RECOGNITION TO THE YOUTH WHO DID 

18 SUCH INCREDIBLE WORK AND THE ARTIST, MISS MADDEN, MISS BACA 

19 AND ALSO THANKS TO MR. RODRIGUEZ FOR THE SUPPORT FOR THE KIDS. 

20 THE ART AND THE POETRY IS ABSOLUTELY INCREDIBLE. FOR ANY OF 

21 YOU WHO WANT TO HAVE THE OPPORTUNITY TO READ IT, I WOULD 

22 RECOMMEND THAT YOU DO SO. AND THEN THANKS PARTICULARLY TO 

23 MIRIAM KRINSKI. SHE'S AN INCREDIBLE PARTNER IN SERVICES TO 

24 YOUTH IN FOSTER CARE AND HAS PROVIDED GREAT LEADERSHIP AT 

25 CHILDREN'S LAW CENTER AND HER LEADERSHIP IN FOSTER CARE 
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1 AWARENESS MONTH HAS REALLY PROPELLED THAT TO THE KIND OF 

2 VISIBILITY ABOUT THE POSITIVE STORIES THAT I THINK IS 

3 IMPORTANT FOR OUR SYSTEM, SO THANKS. [ APPLAUSE ] 

4

5 SUP. KNABE: THANK YOU ALL VERY MUCH. IT'S AN INCREDIBLE 

6 PROGRAM AND I DON'T KNOW IF WE CAN GET A CLOSE-UP OF THIS BUT 

7 THIS IS THE BOOK, "MY PAST, PRESENT AND FUTURE, VOICES OF 

8 FOSTER YOUTH". EXPRESS OUR APPRECIATION TO JUDY, AS WELL, AND 

9 KERRY, AGAIN, THANKS TO THE EXTRA EFFORT. AND MIRIAM, AS 

10 ALWAYS, YOU JUST DO A MAGNIFICENT JOB. SO THANK YOU ALL VERY 

11 MUCH. THANK YOU. [ APPLAUSE ] 

12

13 SUP. KNABE: NEXT, WE HAVE ANOTHER ACTIVE GROUP OF YOUNG PEOPLE 

14 THAT WE'RE GOING TO HONOR TODAY AND I'M GOING TO ASK MR. ROB 

15 ROBERTS, WHO IS PRINCIPAL OF LOS ALTOS HIGH SCHOOL IN HACIENDA 

16 HEIGHTS, ALONG WITH THE STUDENTS AND ADVISORS FROM THE LOS 

17 ALTOS ACADEMY ENGINEERING-- OF ENGINEERING THE BOTBALL TEAM, 

18 WHICH WE'LL EXPLAIN LATER, AND THE BUILD YOUR DREAM TEAM. THE 

19 LOS ALTOS HIGH SCHOOL ACADEMY OF ENGINEERING AND HACIENDA 

20 HEIGHTS WAS ESTABLISHED DURING THE 1989 SCHOOL YEAR, WHEN 

21 ROBERT FRANZ DECIDED TO PROVIDE AN EDUCATIONAL ENVIRONMENT FOR 

22 HIGH SCHOOL STUDENTS TO UNDERTAKE ENGINEERING VENTURES. FOR 

23 YEARS, A NUMBER OF THE TALENTED STUDENTS HAVE GONE THROUGH AND 

24 PARTICIPATED IN MANY PROJECTS OF THE PROGRAM. IN ADDITION TO 

25 BEING A HIGH SCHOOL ELECTIVE COURSE, IT IS ALSO AN R.O.P. 
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1 PROGRAM OFFERED BY THE LA PUENTE VALLEY REGIONAL OCCUPATIONAL 

2 PROGRAM. THE PRIMARY ELEMENT OF THE ENGINEERING ACADEMY'S 

3 VENTURES IS THE GOAL OF EXPERIMENTING AND ENHANCING AND 

4 IMPLEMENTING SOURCES OF ALTERNATIVE ENERGY, WHICH OBVIOUSLY IS 

5 GETTING A LOT OF CONVERSATION TODAY. THROUGH THE BUILDING OF 

6 ELECTRIC AND SOLAR-POWERED VEHICLES, SOLAR-POWERED BOATS, 

7 AUTONOMOUS ROBOTS, EVEN A HYDROGEN FUEL CELL VEHICLE, THE LOS 

8 ALTOS ACADEMY OF ENGINEERING IS CURRENTLY ONE OF THE MOST 

9 ADVANCED PUBLIC HIGH SCHOOL PROGRAMS AVAILABLE IN THE UNITED 

10 STATES OF AMERICA FOR ADOLESCENTS' INTEREST IN HANDS-ON 

11 ENGINEERING EXPERIENCE. DURING THE 2004/2005 SCHOOL YEAR FOR 

12 LOS ALTOS, THE ACADEMY OF ENGINEERS, THEY SWITCHED GEARS FROM 

13 FOCUSING MOSTLY ON SOLAR POWERED VEHICLES AND PROJECTS TO 

14 SPREADING ITS TALENT INTO NINE DIFFERENT AREAS. THE NINE AREAS 

15 INCLUDED THE JPL INVENTION CHALLENGE, THE SOLAR BOAT 

16 COMPETITION, MIDDLE SCHOOL ROBOTICS, THE SOLAR BIKE RACE 

17 U.S.A. COMPETITION AND THE BUILD YOUR DREAM VEHICLE 

18 COMPETITION AND BOTBALL. TODAY, WE HAVE TWO OF THE TEAMS HERE, 

19 BOTBALL AND THE BUILD YOUR DREAM VEHICLE. IN MAY OF 2005, THE 

20 BUILD YOUR DREAM VEHICLE TEAM, KNOWN AS DYNAMIC INNOVATIONS, 

21 WHICH CONSISTED OF NINE MEMBERS, WON FIRST PLACE IN THE 

22 NATIONAL BUILD YOUR DREAM VEHICLE FINALS IN PONTIAC, MICHIGAN, 

23 WITH THEIR DODGE NEON RALLY OPTION. THE ASSIGNMENT, AND I 

24 BELIEVE THERE'S, WHAT, OVER 320 ENTRIES ACROSS THE NATION, AND 

25 THIS TEAM PLACED FIRST. THE ASSIGNMENT FOR THESE STUDENTS WAS 
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1 TO CREATE A LIMITED EDITION MODEL OF AN EXISTING VEHICLE AND 

2 OPTIMIZE ITS AESTHETIC APPEAL, FUEL CONSUMPTION AND 

3 ENGINEERING INGENUITY. SO THEY TOOK A LIMITED EDITION VERSION 

4 OF THE DODGE SRT-4 AND DYNAMIC INNOVATIONS, IT MANAGED TO 

5 MAINTAIN THE SRT 4'S REPUTATION OF BEING THE FASTEST CAR ON 

6 THE MARKET IN ITS PRICE RANGE, AS WELL AS MAKING IT THE BEST 

7 LOOKING ONE. THE LOS ALTOS ENGINEERING ACADEMY'S BOTBALL TEAM 

8 FOR 2004/2005 ALSO HAD QUITE A FEAT AHEAD OF THEM WHEN THEY 

9 FIRST BEGAN WORKING THE BEGINNING OF FEBRUARY 2005. THEIR TASK 

10 WAS TO DESIGN, BUILD AND PROGRAM TWO AUTONOMOUS ROBOTS TO RID 

11 A TABLE OF INNUMEROUS OBJECTS LABELED TRASH AND LABELED 

12 RECYCLE. THE THEME OF THE COMPETITION WAS CLEAN YOUR ROOM SO 

13 YOU CAN PLAY WITH BOT GUY. AND THE LOS ALTOS TEAM DID JUST 

14 THAT BY OUTSCORING OTHER TEAMS BY AN AVERAGE OF 40 POINTS. IN 

15 MARCH OF 2005, THE BOTBALL TEAM, WHICH CONSISTED OF THREE 

16 STUDENTS, SWEPT THE SOUTHERN CALIFORNIA REGIONAL BOTBALL 

17 COMPETITION WITH FOUR FIRST PLACE TROPHIES AND THEN, IN JULY 

18 OF 2005, WITH A TEAM CONSISTING OF SIX STUDENTS, TOOK FIRST 

19 AND THIRD PLACE OVERALL IN THE NATIONAL BOTBALL COMPETITION IN 

20 JACKSONVILLE, FLORIDA. SO WE WANT TO SAY A HEARTFELT 

21 CONGRATULATIONS TO ROB IN LOS ALTOS HIGH SCHOOL BUT 

22 PARTICULARLY THESE YOUNG PEOPLE FOR NOT ONLY THEIR INNOVATIONS 

23 AND CREATIVITY BUT THEIR WILLINGNESS TO STICK TO IT AND, WHO 

24 KNOWS, THEY MAY BE FISHER DESIGN PEOPLE FROM, YOU KNOW, SOME 

25 FUTURE POINT IN TIME AND, WHO KNOWS, THEY MAY BE ABLE TO 
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1 DUPLICATE A ROBOT TO TAKE CARE OF THE BOARD OF SUPERVISORS. 

2 ANYWAY, BUT, ROB, WE WANT TO THANK YOU, CONGRATULATE YOU. WE 

3 TOOK THE TIME UPSTAIRS TO HONOR EACH OF THE KIDS INDIVIDUALLY 

4 BUT A HEARTFELT CONGRATULATIONS. JOB WELL DONE. 

5

6 ROB ROBERTS: THANK YOU VERY MUCH. [ APPLAUSE ] 

7

8 ROB ROBERTS: THANK YOU VERY MUCH, SUPERVISOR. ON BEHALF OF OUR 

9 CONQUER FAMILY, THIS IS A SYMBOL OF ALL THAT'S RIGHT IN PUBLIC 

10 SCHOOLS, AND WE APPRECIATE THE FOURTH DISTRICT BEING-- HAVING 

11 THE OPPORTUNITY TO COME TODAY AND HIGHLIGHT THE GREAT WORK OF 

12 OUR STUDENTS AND WE LOOK FOR A ROLLOUT IN FEBRUARY OF THE ONLY 

13 HYDROGEN FUEL CELL VEHICLE IN PRODUCTION IN A HIGH SCHOOL IN 

14 AMERICA, SO THANK YOU VERY MUCH, SUPERVISOR. [ APPLAUSE ] 

15

16 SUP. KNABE: I MENTIONED, BACK IN 1989, A GENTLEMAN HAD A 

17 VISION, IT'S MR. FRANZ AND WOULD YOU LIKE TO SAY A FEW WORDS? 

18

19 MR. FRANZ: WELL, I'D JUST LIKE TO SAY THANK YOU AND I'M VERY 

20 PROUD OF THE WORK THAT MY STUDENTS HAVE BEEN ABLE TO 

21 ACCOMPLISH. THANK YOU. 

22

23 SUP. KNABE: ALL RIGHT. OKAY. THANK YOU ALL. LET'S GIVE THEM A 

24 BIG ROUND OF APPLAUSE. [ APPLAUSE ] 

25
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1 SUP. KNABE: THIS IS ONE OF THOSE MORNINGS WHERE WE GET TO 

2 HONOR OUR YOUNG PEOPLE AND SEE WHAT'S GOOD WITH AMERICA. WE 

3 STARTED WITH THE FOSTER YOUTH AND THEN SOME INCREDIBLE HIGH 

4 SCHOOL PEOPLE. THIS NEXT YOUNG MAN I'D LIKE TO CALL UP IS ZACK 

5 EWALD FROM BOY SCOUT TROOP 864. ALSO, ALSO, WITH HIM, MARY 

6 ELLEN CARDINAS, THE TROOP COMMITTEE CHAIR, AND HIS MOM AND 

7 DAD. I WANT TO ASK THEM-- OH, THEY'RE RIGHT HERE. SHOCK, 

8 SHOCK. ANYWAY, WE ARE HONORING ZACK TODAY FOR BEING AWARDED 

9 WITH THE BOY SCOUTS OF AMERICA MEDAL OF MERIT FOR HIS HEROIC 

10 ACTIONS WHICH SAVED A YOUNG CHILD FROM DROWNING. THE MEDAL OF 

11 MERIT IS BESTOWED UPON THOSE WHO DISPLAY AN OUTSTANDING ACT OF 

12 SERVICE, EXCEPTIONAL CHARACTER AND REFLECTION AND COMMON 

13 DEGREE OF CONCERN FOR THE WELLBEING OF OTHERS. IN AUGUST OF 

14 LAST YEAR, WHILE CAMPING WITH HIS FAMILY IN YELLOWSTONE 

15 NATIONAL PARK, ZACK RISKED HIS OWN LIFE TO SAVE A YOUNG CHILD 

16 FROM DROWNING AFTER FALLING INTO A VERY DANGEROUS SECTION OF 

17 THE GARDNER RIVER. ZACK WAS AMONG ONLY 5 SCOUTS IN THE ENTIRE 

18 UNITED STATES TO RECEIVE THE MEDAL OF MERIT AWARD THIS YEAR, 

19 SO WE WANT TO THANK ZACk FOR HIS BRAVERY, CONGRATULATE HIM AND 

20 OBVIOUSLY HE'S A VERY COMPASSIONATE YOUNG MAN AND WISH HIM 

21 WELL IN ALL HIS FUTURE ENDEAVORS. ZACK, CONGRATULATIONS. [ 

22 APPLAUSE ] 

23

24 SUP. ANTONOVICH: FIRST, WE WOULD LIKE TO WELCOME TO OUR COUNTY 

25 OF LOS ANGELES THE NEW ASSISTANT DIRECTOR IN CHARGE OF THE 
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1 FEDERAL BUREAU OF INVESTIGATION AND THAT'S STEPHEN TIDWELL, AS 

2 HEAD OF THE L.A. DIVISION, WHICH IS THE THIRD LARGEST IN THE 

3 COUNTRY. TIDWELL'S DISTRICT DIRECTS MORE THAN 1,000 F.B.I. 

4 AGENTS AND ANALYSTS IN SEVEN COUNTIES. A 22 YEAR VETERAN OF 

5 THE BUREAU, HE ENTERED DUTY WITH THE F.B.I. BACK IN JUNE OF 

6 1983. HE RECENTLY SERVED AS HEAD OF THE F.B.I.'S CRITICAL 

7 INCIDENT RESPONSE UNIT, A UNIT CREATED IN 1994 TO RESPOND IN 

8 THE UNITED STATES AND ABROAD TO TERRORIST ACTS AND HOSTAGE 

9 SITUATIONS, IN THAT CAPACITY AS SUPERVISOR OF THE F.B.I. 

10 SECURITY EFFORTS AT THE SUMMER OLYMPICS IN ATHENS, GREECE, 

11 LAST YEAR. HE'S ALSO SERVED AS A SPECIAL AGENT IN CHARGE OF 

12 THE LOUISVILLE FIELD OFFICE, WHERE HE WAS ON THE SCENE 

13 COMMANDER DURING THE HEAVILY PUBLICIZED SNIPER INVESTIGATION 

14 IN THE WASHINGTON, D.C. AREA. SO MANY THANKS FOR JOINING US. 

15 WE LOOK FORWARD TO WORKING WITH YOU. WE'VE HAD A VERY GOOD 

16 COOPERATIVE EFFORT, ESPECIALLY DURING THIS TIME OF TERRORIST 

17 ALERTS AND TRAINING AND BRIEFINGS AND WE APPRECIATE THAT AND 

18 WE LOOK FORWARD TO HAVING CONTINUED CLOSE RELATIONSHIP WITH 

19 YOU. [ APPLAUSE ] 

20

21 J. STEPHEN TIDWELL: THANK YOU, SUPERVISOR ANTONOVICH AND OTHER 

22 MEMBERS OF THE BOARD OF SUPERVISORS. LOS ANGELES HAS A 

23 STERLING REPUTATION AS ONE OF THE FRONT LEADING COUNTIES IN 

24 AMERICA FOR PUBLIC SAFETY AND, IN POST-9/11, BEING BUSY AND 

25 ABOUT THE BUSINESS OF THE PREVENTING TERRORISM. I LOOK FORWARD 
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1 TO WORKING WITH YOU AND WITH SHERIFF BACA AND OTHER MEMBERS OF 

2 YOUR PUBLIC SAFETY COMMUNITY IN JOINING THIS GREAT TEAM. THANK 

3 YOU, SIR. [ APPLAUSE ] 

4

5 SUP. ANTONOVICH: NOW WE WOULD LIKE TO WELCOME SEVERAL 

6 REPRESENTATIVES FROM THE JUVENILE DIABETICS RESEARCH 

7 FOUNDATION TO OUR BOARD AND THAT'S-- WITH US TODAY IS 

8 ALEXANDRA HEART, WHO IS THEIR OUTREACH PROGRAM COORDINATOR, 

9 MARK REEK, L.A. COUNTY EXECUTIVE DIRECTOR AND LUKE STOCKUS, 

10 WHO IS BOARD MEMBER, AND HIS WIFE, SCOTTIE, AND THEIR SON, 

11 MAC, WHO HAS TYPE 1 DIABETES. TYPE 1 OR JUVENILE DIABETES 

12 USUALLY STRIKES IN CHILDHOOD, ADOLESCENTS OR YOUNG ADULTHOOD, 

13 BUT IT DOES LAST A LIFETIME. THE RISK OF DEVELOPING TYPE 1 

14 DIABETES IS HIGHER THAN VIRTUALLY ALL OTHER SEVERE CHRONIC 

15 DISEASES OF CHILDHOOD. FOUNDED IN 1970 BY GROUPS OF PARENTS OF 

16 CHILDREN WITH DIABETES, THE MISSION OF THE JUVENILE DIABETIC 

17 RESEARCH FOUNDATION IS TO FIND A CURE FOR DIABETES AND ITS 

18 COMPLICATIONS THROUGH THE SUPPORT OF RESEARCH. THEIR A LEADING 

19 CHARITABLE FOUNDER AND ADVOCATE OF TYPE 1 RESEARCH WORLDWIDE 

20 AND WE THANK YOU FOR BEING HERE AND WE WOULD LIKE TO GIVE YOU 

21 THIS PROCLAMATION ON BEHALF OF THE COUNTY. 

22

23 SPEAKER: THANK YOU, SUPERVISOR ANTONOVICH AND MEMBERS OF THE 

24 BOARD. WE REGRET THAT SCOTTIE COULDN'T BE HERE THIS MORNING. 

25 HE HAD A TEST SO WE TOLD HIM WE THOUGHT HE BEST GO TO SCHOOL. 
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1 BUT FOR THE SUPPORT THAT YOU'VE PROVIDED OVER THE YEARS, 

2 SUPERVISOR, WE'RE GREATLY APPRECIATIVE. IT'S BEEN STEADFAST 

3 AND, YOU KNOW, FOR THE HUNDREDS OF THOUSANDS OF CHILDREN, 

4 YOUNG PEOPLE AND THEIR PARENTS THAT WAKE UP EVERY MORNING IN 

5 OUR COUNTY AND HAVE TO FACE THIS DREADED DISEASE, IT'S A REAL 

6 PROBLEM, AND THEIR ONLY HOPE IS A CURE AND THAT'S THEIR WISH 

7 AND THAT'S OUR GOAL AND OUR ONLY MISSION AND WE WON'T STOP 

8 UNTIL WE'RE DONE. THANK YOU VERY MUCH. [ APPLAUSE ] 

9

10 SUP. ANTONOVICH: NOW THE TEMPLE CITY UNIFIED SCHOOL DISTRICT'S 

11 50TH YEAR CELEBRATION COMMITTEE WITH THE ASSISTANCE FROM THE 

12 TEMPLE CITY CHAMBER OF COMMERCE IS SPONSORING A 50-YEAR 

13 COMMUNITY TIMES CAPSULE PROJECT. IT WILL CONTAIN HISTORICAL 

14 ARTIFACTS AND MEMORABILIA. IT'S GOING TO BE BURIED DURING A 

15 CEREMONY IN THE SPRING, TO BE UNEARTHED 50 YEARS FROM NOW 

16 DURING THE TEMPLE CITY'S UNIFIED SCHOOL DISTRICT'S 100TH 

17 ANNIVERSARY. AND ONE OF THE GREAT DOCUMENTS IN THAT WILL BE A 

18 DOCUMENT SIGNED BY THE FIVE SUPERVISORS OF THE COUNTY OF LOS 

19 ANGELES. IT ALSO INCLUDES A COUNTY INFORMATION PACKAGE, AS 

20 WELL AS PHOTOS, C.D.S, LETTERS AND OTHER CONTRIBUTIONS FROM 

21 EACH OF OUR SUPERVISORIAL DISTRICTS. SPECIAL THANKS TO CHIEF 

22 MASTER SERGEANT EUGENE EGGERS, WHO BROUGHT THIS PROJECT TO MY 

23 OFFICE SO THAT THE COUNTY WOULD HAVE A CHANCE TO BE INCLUDED. 

24 WE WISH THE TEMPLE CITY UNIFIED SCHOOL DISTRICT AND THE TEMPLE 

25 CITY CHAMBER OF COMMERCE SUCCESS WITH THIS PROJECT AND THIS IS 
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1 AN EXAMPLE-- THIS IS THE TIME CAPSULE THAT EVERYTHING WILL BE 

2 IN. CONGRATULATIONS. [ APPLAUSE ] 

3

4 SPEAKER: THANK YOU, SUPERVISOR ANTONOVICH, FOR THIS HONOR OF 

5 GETTING BACK THE COUNTY TIME CAPSULE. JUST TO LET YOU KNOW, WE 

6 HAVE 102 OF THESE CAPSULES ARE GOING TO BE BURIED IN A 

7 CONCRETE VAULT ON TEMPLE CITY HIGH SCHOOL GROUNDS. AGAIN, AS 

8 THE SUPERVISOR SAID, IT WILL BE OPENED UP IN 50 YEARS. WE'VE 

9 HAD GOOD SUCCESS WITH THIS. WE HAVE THE TEMPLE CITY SHERIFF'S 

10 STATION, THEY'RE GOING TO CONTRIBUTE ONE, WE HAVE THE GOVERNOR 

11 SCHWARZENEGGER, HE'S GOING TO CONTRIBUTE HIS TIME CAPSULE, 

12 JUST LIKE THIS ONE, AND, ON BEHALF OF THE COMMITTEE, WE'D LIKE 

13 TO EXTEND TO THE SUPERVISORS, IF THEY WOULD LIKE TO 

14 PARTICIPATE IN THIS, WE WOULD MAKE THEM HONORARY TEMPLE 

15 CITYIANS. I HAVE APPLICATIONS FOR THEM IF THEY'D LIKE TO 

16 PARTICIPATE. I'M GOING TO LEAVE IT HERE FOR THEM TO PASS OUT 

17 AND IF THEY NEED ANY INFORMATION, THEY CAN CONTACT ME. I LEFT 

18 MY CARD HERE AS WELL. AGAIN, THANK YOU. 

19

20 SUP. ANTONOVICH: LET ME MAKE SOME MORE PRESENTATIONS HERE. 

21 FIRST, TO THE UNITED STATES AIR FORCE CHIEF MASTER SERGEANT, 

22 EUGENE EGGERS. AND REPRESENTING THE TEMPLE CITY UNIFIED SCHOOL 

23 DISTRICT IS GAYLE SCHAFFER. REPRESENTING THE TEMPLE CITY 

24 CHAMBER OF COMMERCE IS JOHN ZUBRECK, THE CHAIRMAN OF THE 

25 BOARD; PHILLIP PETROS, THE NEWSPAPER PUBLISHER; AND JENNIFER 
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1 WOLF, WHO IS A CHAMBER MEMBER. CONGRATULATIONS. HOW MANY ARE 

2 GOING TO BE HERE IN 50 YEARS TO WATCH IT BE OPENED? OKAY. NOW 

3 TO BRING ADOPTION MONTH TO A CLOSE, IF YOU REMEMBER, WE OPENED 

4 THAT PROGRAM EARLIER THIS MONTH, NOW WE'RE CLOSING IT BUT 

5 WE'RE NOT GOING TO CEASE BEING ACTIVELY INVOLVED IN CUTTING 

6 THE RED TAPE TO HAVE THESE CHILDREN ADOPTED. HERE'S DR. DAVID 

7 SANDERS, OUR DIRECTOR, AND WE'RE GOING TO RECOGNIZE THE HEART 

8 GALLERY PHOTO EXHIBIT, WHICH IS ONE OF THE MANY STRATEGIES 

9 BEING USED BY OUR DEPARTMENT TO ENCOURAGE FAMILIES TO COME 

10 FORWARD AND PROVIDE A PERMANENT HOME TO A WAITING CHILD. THE 

11 HEART GALLERY WAS STARTED IN NEW MEXICO BY ONE SOCIAL WORKER 

12 AND A SMALL GROUP OF COMMUNITY MEMBERS WHO CAME UP WITH A 

13 HEARTWARMING APPROACH TO FIND PERMANENCIES FOR THESE CHILDREN. 

14 THE HEART GALLERY IN LOS ANGELES COUNTY KICKED OFF IN EARLY 

15 NOVEMBER AT HIGHLANDS NIGHTCLUB AND WILL TRAVEL AROUND LOS 

16 ANGELES COUNTY TO VARIOUS SHOPPING CENTERS. THE PICTURES OF 

17 THESE YOUNG CHILDREN WERE TAKEN BY PHOTOGRAPHERS WHO DONATED 

18 THEIR TIME AND SKILL, SEVERAL OF WHICH ARE HERE THIS MORNING. 

19 WE WANT TO THANK THEM VERY MUCH BECAUSE, FOR EVERY CHILD THAT 

20 WE FIND A PERMANENT HOME FOR, IS A CHILD THAT TO BE ABLE TO 

21 PROVIDE AN OPPORTUNITY FOR THEM TO CONTINUE WITH THEIR 

22 EDUCATION AND BECOME THE GREAT PRODUCTIVE CITIZENS THAT OUR 

23 COUNTY, STATE AND NATION NEED. SO FIRST, LET ME GIVE THIS TO 

24 DR. DAVID SANDERS ON THE HEART GALLERY PHOTO EXHIBIT. AND 
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1 LINDA HOYT, WHO ALMOST SINGLE HANDEDLY BROUGHT THE HEART 

2 GALLERY TO OUR COUNTY. [ APPLAUSE ] 

3

4 SUP. ANTONOVICH: LESLIE BARTON, WHO TOOK MANY PHOTOGRAPHS AND 

5 ALSO DEVELOPED THEM AND FRAMED THEM. [ APPLAUSE ] 

6

7 SUP. ANTONOVICH: MAUREEN MCGRATH, WHO IS AN ADOPTIVE PARENT 

8 AND DONATED USE OF THE HIGHLANDS HOLLYWOOD FOR THE HEART 

9 GALLERY KICKOFF. [ APPLAUSE ] 

10

11 SUP. ANTONOVICH: AND DAVID BALK, A PHOTOGRAPHER. HE'S NOT 

12 HERE. OKAY. JENNIFER LESHNICK, A PHOTOGRAPHER. [ APPLAUSE ] 

13

14 SUP. ANTONOVICH: AND KELLY SQUIRES-TAYLOR, ANOTHER 

15 PHOTOGRAPHER. [ APPLAUSE ] 

16

17 SUP. ANTONOVICH: AND LOC NGUYEN, SUPERVISING CHILDREN'S SOCIAL 

18 WORKER FOR D.C.F.S. [ APPLAUSE ] 

19

20 SUP. ANTONOVICH: THESE ARE EXAMPLES OF THE PHOTOGRAPHY THAT 

21 THESE WONDERFUL VOLUNTEERS DID FOR THE CHILDREN THAT ARE ON 

22 DISPLAY TODAY. ZEV AND YVONNE, YOU CAN SEE THIS IS THE 

23 PROFESSIONALISM AND THE APPROACH THAT OUR DEPARTMENT-- BECAUSE 

24 IF YOU PUT ALL THE CHILDREN IN FOSTER CARE, UNDER DEPENDENCY 

25 IN THE COUNTY OF LOS ANGELES, THEY'D BE THE 66TH LARGEST CITY 
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1 IN THE COUNTY OF LOS ANGELES IF THEY ALL LIVED IN ONE AREA AND 

2 THAT'S WHY IT'S SO IMPORTANT THAT WE FIND HOMES FOR THESE 

3 CHILDREN. DAVID, WHY DON'T YOU-- OH, WAIT, WE HAVE-- OKAY, 

4 SHERRY GRANT, WHO HAS WORKED TIRELESSLY ON ALL OF THE ADOPTION 

5 MONTH ACTIVITIES FOR THE DEPARTMENT. [ APPLAUSE ] 

6

7 DR. DAVID SANDERS: THANK YOU, SUPERVISOR ANTONOVICH, FOR YOUR 

8 TIRELESS ADVOCACY FOR ADOPTION FOR CHILDREN IN FOSTER CARE AND 

9 THANKS TO THE BOARD FOR THE RECOGNITION. THE HEART GALLERY, 

10 THE OPENING WAS JUST AN INCREDIBLE SUCCESS. THE HIGHLANDS 

11 OPENED THEIR FACILITY SO THAT WE COULD HAVE THE PHOTOGRAPHS 

12 THERE. WE HAVE BEAUTIFUL PHOTOGRAPHS OF CHILDREN AND 

13 CAREGIVERS AND CHILDREN THAT ARE AVAILABLE FOR ADOPTION AND 

14 WE'RE JUST REALLY PROUD OF THE WORK THAT'S BEEN DONE AND 

15 THANKS, TOO, TO THE ADOPTION STAFF AND TO SHERRY GRANT, WHO 

16 HAS PROVIDED INCREDIBLE LEADERSHIP AND CONSIDERABLE COMMITMENT 

17 AND TIME FOR THIS EFFORT, TOO, SO THANKS ONCE AGAIN. [ 

18 APPLAUSE ] 

19

20 SPEAKER: AND I JUST WANT TO SAY, ON BEHALF OF THE 

21 PHOTOGRAPHERS, THAT I HAVE TO SAY IT WAS EVERYBODY'S 

22 EXPERIENCE THAT IT WAS SO HEARTWARMING AND THE CHILDREN THAT 

23 WE PHOTOGRAPHED WERE LOVELY AND FUN AND IT WAS A COMPLETE JOY 

24 AND CERTAINLY DISPELLED A LOT OF FOSTER CARE MYTHS IN OUR 
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1 EYES. AND THE WHOLE PROJECT HAS BEEN INCREDIBLY HEARTWARMING. 

2 THANK YOU. [ APPLAUSE ] 

3

4 SPEAKER: HI. AS CHAIRPERSON, I JUST WANT TO SAY IT'S BEEN AN 

5 HONOR AND PLEASURE. WE ENCOURAGE THE PUBLIC TO VISIT THIS 

6 LOVELY EXHIBIT STARTING AT FOX HILL'S MALL. IT'S THERE RIGHT 

7 NOW FOR THE NEXT COUPLE OF DAYS. AND IT REALLY ENCOURAGES THE 

8 PUBLIC TO TAKE A LOOK AT FOSTER CARE OF THESE LOVELY CHILDREN 

9 WHO NEED BEAUTIFUL HOMES AND WE ENCOURAGE EVERYONE TO VISIT 

10 THAT. THANK YOU SO MUCH. [ APPLAUSE ] 

11

12 SPEAKER: IT'S AT THE FOX HILLS MALL, FOX HILLS MALL, THEN IT 

13 WILL GO ON TO DEL AIR MALL FASHION CENTER AND SOME OTHER MALLS 

14 THROUGHOUT AND WEST COVINA MALL AFTER THAT. 

15

16 SUP. ANTONOVICH: THE WEST HILLS? 

17

18 SPEAKER: NOT ALL THE WEST HILLS. 

19

20 SUP. ANTONOVICH: THOSE WHO ARE WATCHING THAT ARE INTERESTED IN 

21 BECOMING A FOSTER ADOPTIVE PARENT, YOU CAN CALL THE HOTLINE, 

22 IT'S 888-811-1121 FOR ADDITIONAL INFORMATION. 888-811-1121. 

23 AND WE'RE ENGAGING OUR FAITH-BASED COMMUNITY, GETTING OUR 

24 CHURCHES AND OUR SYNAGOGUES INVOLVED. WE HAD AN OUTREACH 

25 PROGRAM JUST RECENTLY IN ARCADIA AT THE ARBORETUM WHERE WE HAD 
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1 MEMBERS OF THE LOCAL CHURCHES AND SYNAGOGUES THERE TO PROVIDE 

2 INFORMATION AND HAVE-- THE DEPARTMENT WOULD LIKE TO DESIGNATE 

3 A PERSON FROM EACH CONGREGATION TO INTERFACE WITH THE PERSON 

4 REPRESENTED FROM THE DEPARTMENT AND BE INVOLVED IN FINDINGS 

5 THOSE HOMES FOR THOSE CHILDREN, SO LET'S DO A GROUP PICTURE. 

6 AND TO WRAP IT UP, WE HAVE LITTLE DASH, WHO IS A DOMESTIC 

7 SHORT HAIR, MALE, EIGHT WEEKS OLD, WHO IS ALSO LOOKING FOR A 

8 HOME. WANT TO SAY SOMETHING? SO HERE IS LITTLE DASH. ANYBODY'D 

9 LIKE TO ADOPT DASH, YOU CAN CALL THE HOTLINE NUMBER AT THE 

10 BOTTOM OF YOUR SCREEN, 562-728-4644. [ MEOWING ] 

11

12 SUP. ANTONOVICH: YOU WANT TO SAY SOMETHING? [ MEOWING ] 

13

14 SUP. ANTONOVICH: AHHH. LOOK IN THE CAMERA, MAYBE GET YOU A 

15 HOME. [ MEOWING CONTINUES ] 

16

17 SUP. ANTONOVICH: WANT TO GO TO THE SHERIFF'S DEPARTMENT? SEE 

18 EVERYBODY, DASH? [ MEOWING ] 

19

20 SUP. BURKE: I HAVE NO PRESENTATIONS. 

21

22 SUP. ANTONOVICH: SUPERVISOR YAROSLAVSKY? 

23

24 SUP. YAROSLAVSKY: I DON'T HAVE ANY ADJOURNING MOTIONS, MR. 

25 CHAIRMAN BUT I-- WHY DON'T WE JUST TAKE UP A FEW OF THE HOLDS, 
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1 ITEM 18. YOU HAD A NUMBER OF-- ARE WE HOLDING-- I WANT TO TAKE 

2 UP THE PUBLIC PEOPLE WHO HAVE-- THE PUBLIC WHO HAVE ASKED TO 

3 BE HEARD ON ITEM 18. 

4

5 SUP. ANTONOVICH: OKAY. YVONNE MICHELLE AUTRY AND WARREN 

6 WILLIAMS. WARREN WILLIAMS. GO AHEAD. 

7

8 YVONNE MICHELLE AUTRY: THIS IS REGARDING 35-A OR 18? 

9

10 SUP. ANTONOVICH: THIS-- THE ITEM WE'RE ON NOW IS 18. 

11

12 YVONNE MICHELLE AUTRY: SO WE'LL HAVE TO ADDRESS BOTH AT THE 

13 SAME TIME OR WILL WE HAVE...? 

14

15 SUP. YAROSLAVSKY: YES, WHY DON'T YOU DO THAT. 

16

17 SUP. ANTONOVICH: WHY DON'T YOU DO THEM AT THE SAME AND THEN, 

18 WARREN, WE HAD ALREADY PASSED, PRIOR TO YOU BEING HERE, 19, 

19 21, 39, 40, 41, IF YOU JUST WANT TO MAKE SOME COMMENTS ON 

20 AND... 

21

22 YVONNE MICHELLE AUTRY: CAN I HAVE THREE MINUTES FOR EACH ITEM? 

23

24 SUP. ANTONOVICH: I WOULD CONDENSE IT. 

25
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1 YVONNE MICHELLE AUTRY: WELL, TO THE BEST OF MY ABILITY FOR 

2 FIRST ADDRESSING ITEM 18, I WOULD ENCOURAGE THE BOARD TO USE 

3 ANY MONEYS AVAILABLE, LIKE WE'VE SAID PRIOR, TO INVESTIGATE 

4 WHY CHILDREN ARE BEING MURDERED OR SACRIFICED OR EXPERIMENTED 

5 ON, UNNECESSARILY DRUGGED, THOSE THAT HAVE BEEN RAPED, ABUSED. 

6 SARA C. WENT IN THE HOSPITAL FOR A BROKEN ARM AND I DON'T KNOW 

7 HOW SHE SUFFERED FATAL INJURIES AND I THINK THAT SOME OF THE 

8 MONEYS SHOULD BE USED TO INVESTIGATE WHAT IS HAPPENING TO 

9 THESE CHILDREN. WHEN PARENTS EXPOSE THE ABUSE SUFFERED BY 

10 CHILDREN IN THE CUSTODY OF THE DEPARTMENT OF CHILDREN AND 

11 FAMILY SERVICES, WE ARE CALLED CHILD MOLESTERS, CRAZY, 

12 ALCOHOLICS, CRACK ADDICTS, BIPOLAR, MANIC DEPRESSIVE, 

13 HOMELESS, ILLITERATE, TERRORISTS. I'VE BEEN ACCUSED OF ALL THE 

14 ABOVE, NOT TO MENTION WITCHES AND GANG BANGERS, AXE MURDERERS 

15 AND NONE OF IT IS TRUE, OKAY? I WAS EDUCATED AT U.C.L.A., I 

16 WAS BORN IN INGLEWOOD 39 YEARS AGO, I'M MULTI-LINGUAL AND I'VE 

17 BEEN FALSELY ACCUSED OF PERPETRATING ABUSE AND NEGLECT OF MY 

18 CHILD, WHICH HAS NEVER BEEN PROVEN. IT'S ALL BEEN BASED ON 

19 HEARSAY. I THINK THESE MONEYS SHOULD BE USED NOT TO COVER UP 

20 THE ABUSE OF THE CHILDREN SO THAT YOU'LL HAVE A FUTURE 

21 GENERATION OF PRISON FODDER AND A FUTURE GENERATION OF WORKING 

22 CLASS INDIVIDUALS WHO ARE DYSFUNCTIONAL TO MAINTAIN THE STATUS 

23 QUO OF WHITE SUPREMACY IN THIS COUNTRY OR JUST TO MAINTAIN THE 

24 STATUS QUO SO THAT THOSE WHO ARE EDUCATED STAY IN POWER AND 

25 THAT THEY ARE ABLE TO BE FUNCTIONAL-- AS FUNCTIONAL 
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1 INDIVIDUALS BECAUSE THE MAJORITY OF FOSTER CHILDREN ARE 

2 DYSFUNCTIONAL, DISADVANTAGED ECONOMICALLY OR THEY BECOME 

3 INVOLVED IN CRIMINAL ACTIVITY OR GO INTO THE PRISONS OR BECOME 

4 HOMELESS AND THEY'RE NOT-- THEY USUALLY DO NOT BECOME 

5 PARTICIPATING, CONTRIBUTING MEMBERS OF THE COMMUNITY. AND I DO 

6 BELIEVE THAT THIS IS NOT BY CHANCE. I DON'T WANT TO SAY IT'S A 

7 CONSPIRED EFFORT BUT I DO BELIEVE THAT IT IS AND I WANT TO 

8 EXPOSE THAT. THE CHILDREN THAT WOULD LIKE TO SPEAK, AS WELL AS 

9 THE PARENTS, THE CHILDREN ARE THEN MEDICATED, THEY'RE LABELED 

10 IMBALANCED, ATTENTION DEFICIT DISORDER SUFFERERS, CHILDREN 

11 THAT HAVE ANGER MANAGEMENT PROBLEMS. WELL, OF COURSE, BECAUSE 

12 THEY'RE BEING ABUSED, JUST LIKE PARENTS ARE WHO HAVE BEEN 

13 FALSELY ACCUSED BECAUSE WE DO NOT HAVE OUR CHILDREN TO JUSTIFY 

14 THE MAINTENANCE OF THIS CLASS SYSTEM. CHILDREN THAT ARE ABUSED 

15 ARE NOT ABLE TO WORK AND EXPRESS THEMSELVES AND FUNCTION ON 

16 THE SAME LEVEL OF MOST CHILDREN FROM MIDDLE AND UPPER CLASS 

17 FAMILIES AND BETTER ENVIRONMENTS. SO, LIKE I SAID, THAT WAS 

18 JUST FOR THE RECORD. WE'VE STATED THAT PROBABLY HUNDREDS OF 

19 TIMES IN THE LAST TWO YEARS, ALL TO NO AVAIL, BUT, AGAIN, THIS 

20 IS PROBABLY GOING TO BE ONE OF THE FINAL STATEMENTS THAT I 

21 MAKE REGARDING THAT ISSUE. ABOUT THE HOMELESS, I THINK THAT, 

22 YES, IT'S VERY NICE TO HAVE A PROJECT HOMELESS CONNECT DAY, 

23 SUPERVISOR YAROSLAVSKY, I THINK IN ALL ALTRUISM. BUT I THINK 

24 THAT THE REAL-- I MEAN, I LIVE DOWNTOWN. I SEE A LOT OF THE 

25 HOMELESS, AND I SEE THAT THEY ARE BEING PROBABLY USED IN A LOT 
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1 OF EXPERIMENTS PERPETRATED BY MICHAEL MALONEY, WHO IS A COUNTY 

2 COMMISSION PSYCHIATRIST. THEY NEED JOBS, THEY NEED 

3 DETOXIFICATION AND THEY NEED SOME PROGRAMS TO MAKE THEM 

4 CONFIDENT THAT THEY CAN BE FUNCTIONAL. I THINK THEY'RE BEING 

5 USED IN EXPERIMENTS FOR THEIR MELANIN, INTERFERON OR JUST, YOU 

6 KNOW, SOME TYPE OF DEMOGRAPHIC EXPERIMENTS. I LIVE HERE AND I 

7 TALK TO THEM, OKAY? THEY'RE TOXIC, THEY'RE ON MEDICATION, 

8 THERE'S SOMETHING POSSIBLY IN THE FOOD, WHO KNOWS, THAT KEEPS 

9 THEM AT A LEVEL OF UNCONSCIOUSNESS WHERE THEY DO NOT WANT TO 

10 DO ANYTHING. AND IF IT WASN'T FOR THE LORD, I'D BE THERE. LIKE 

11 I SAID, BECAUSE OF THIS CONSPIRED EFFORT AND I'M NOT PARANOID, 

12 I WOULDN'T BE HERE AND EMPLOYED, WORKING FOR MYSELF, DESPITE 

13 THE ENTRAPMENTS, LIES AND LOOK-ALIKES, TODAY, EVEN POLICEMEN 

14 APPEARED AT MY DOOR FOR SOMEONE WHO HAD LIED AND SAID THAT I 

15 WAS ATTACKING SOMEONE WHO HAD BEEN HARASSING ME, SIMPLY 

16 BECAUSE WE'RE VOCAL, I BELIEVE. SO I KNOW WE'RE IN THE 

17 LIMELIGHT AND WE'RE IN THE LINE OF FIRE. BUT, AGAIN, I THINK 

18 THESE MONEYS SHOULD BE USED TO REALLY EXPOSE WHAT'S HAPPENING 

19 IN THE MAINTENANCE OF THIS CLASS SYSTEM. THANK YOU. 

20

21 SUP. ANTONOVICH: THANK YOU. OKAY, MR. WILLIAMS. 

22

23 WARREN WILLIAMS: YOU KNOW, THERE'S A PROBLEM IN OBSERVING THE 

24 BOARD MEETING OF LAST WEEK. I NOTICE HOW THE VISUAL IS SHOWING 

25 THE ONE NUMBER IN WHICH YOU HAVE US SPEAKING UNDER AND 
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1 MICHELLE AND I BOTH ADDRESS, LIKE OTHER PEOPLE HAVE IN THE 

2 PAST, AND THAT'S COMPLETE REPRESENTATION, BECAUSE MOST PEOPLE 

3 CAN'T FOLLOW ALL THE OTHER AGENDA ITEMS THAT I AM GOING TO 

4 ADDRESS NOW. AND IF THEY'RE GOING TO FORCE US TO SPEAK ON ALL 

5 THESE AGENDA ITEMS, THEN THEY NEED TO STOP THAT TAPE FROM 

6 RUNNING THAT'S SAYING WE'RE TALKING ABOUT ONE AGENDA ITEM SO 

7 PEOPLE CAN INTERPRET AND COMPREHEND THAT WE'RE NOT JUST 

8 TALKING ABOUT THAT ONE AGENDA ITEM. CONTINUING FORWARD WITH 

9 THAT IN MIND, I'M ALSO ASKING FOR A WRITTEN RESPONSE TO EVERY 

10 ITEM THAT I BRING UP, AS WELL AS I BROUGHT UP IN THE PAST OF 

11 LAST WEEK, BECAUSE THOSE ISSUES STILL RELEVANT AND THEY RELATE 

12 TO THESE ITEMS. ON NUMBER 85-A, THE PROJECT HOMELESS 

13 CONNECTION DAY, WHAT TYPE OF CONNECTION ARE WE MAKING WITH THE 

14 HOMELESS WHEN, AGAIN, WE NEED TO BE ELIMINATING HOMELESSNESS 

15 IN L.A. COUNTY? HOMELESSNESS IS KIND OF LIKE THE VOICES OF 

16 FOSTER YOUTH. YOU PARADE A COUPLE OF PEOPLE ON THE STAGE AND A 

17 LOT OF PEOPLE WHO ARE MAKING A LOT OF MONEY OFF THE CHILDREN 

18 AND THEN ALLEGE THAT THESE CHILDREN HAVE SUCH WONDERFUL 

19 VOICES, WHEN A LOT OF CHILDREN IN THE SYSTEM ARE COMPLAINING 

20 ABOUT BEING ABUSED, RAPED. MACLAREN HALL IS STILL A VERY LIVE 

21 ISSUE FOR PEOPLE LIKE MYSELF, PROVING THAT THIS COUNTY IS 

22 GUILTY OF CHILD MOLESTATION. THIS BOARD IS GUILTY OF MURDER, 

23 OF WRONGLY MEDICATING CHILDREN, DESTROYING FAMILIES AND A LOT 

24 OF OTHER CRIMES. AND, YOU KNOW, YOU PARADE THEM ON AND SAY 

25 VOICES OF YOUTH IS LIKE THE VOICES OF THE HOMELESS. YOU SEE 



November 29, 2005

40

1 THE HOMELESS OUT HERE EVERY DAY WITH THIS COUNTY, IT'S A 

2 FAILURE THEN BECAUSE IT IS NOT SOLVED, THERE'S HOMELESS ISSUES 

3 AFTER ALL THESE MANY YEARS. ON ITEM NUMBER 18, DELIVERING 

4 SUBPOENAS, I PERSONALLY HAVE EXPERIENCED FRAUD IN THAT SYSTEM 

5 WHERE THEY ALLEGE THEY SENT ME NOTICE WHEN THEY DIDN'T. WHEN 

6 YOU MAKE THIS LEGAL BINDING AND PAY PEOPLE DO IT, THEN THEY'RE 

7 USING THE LEGAL PROCESS OF SIMPLY SUGGESTING THAT THEY HAVE 

8 FILED NOTICE. THAT DOESN'T MEAN THAT THEY HAVE. IN MY 

9 SITUATION, THEY SENT A COMMUNICATION WITHIN THE OFFICE ITSELF 

10 AND THEN LIED AND SAID THAT THEY SENT IT TO ME IN SOME TYPE OF 

11 MAIL TELEGRAM PROCESS, BUT THE NUMBER TO IDENTIFY WHEN THEY'RE 

12 ALL NUMBERS. SO ALL THESE THINGS, I OPPOSE AND NONE OF THEM 

13 SHOULD BE FUNDED BECAUSE WE DO THE NEUTRAL ENTITIES AND NOT 

14 JUST THE COUNTY PEOPLE ABLE TO COVER UP ITS WRONGDOING. ON 

15 ITEM NUMBER 19, THE SAME THING EXISTS, THE URINE SAMPLES AND 

16 THE DRUG AND ALCOHOL TESTING SHOULD BE DONE BY OTHER ENTITIES 

17 AND NOT JUST FUNDING ONE TO DO IT. ON NUMBER 21, WHAT ARE WE 

18 DOING? HIRING THE UNTOUCHABLES ALL OVER AGAIN? TALKING ABOUT 

19 3-1/2 MILLION PLUS DOLLARS TO HAVE A SPECIAL GROUP LIKE, YOU 

20 KNOW, TO ADDRESS FRAUD IN THE COUNTY AND SO ON AND SO FORTH? 

21 WELL, WHO IS DEALING WITH THE FRAUD, AGAIN, OF SOCIAL WORKERS, 

22 LAW ENFORCEMENT AND OTHERS? SO IT SHOULDN'T BE FUNDED. REQUEST 

23 FOR PROPOSALS SHOULD DEFINITELY BE FOCUSED ON MAJOR REQUEST 

24 PROPOSALS THAT ARE CITIZEN FRIENDLY. YOU THROW THESE THINGS 

25 OUT HERE, YOU'RE NOT ADVERTISING IN A LOT OF BLACK NEWSPAPERS 
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1 IN THE INNER CITY AND OTHER LOCATIONS SO PEOPLE ARE EVEN AWARE 

2 OF WHAT TYPE OF OPPORTUNITY THEY HAVE IN GETTING FUNDING. I'VE 

3 TALKED TO A GROUP OF PERSONS ON THE HOMELESS ISSUE. A LOT OF 

4 PERSONS DO RESPOND AFTER SEEING THESE BOARD MEETINGS AND THEY 

5 DO SUPPORT IT BUT THEY DON'T BELIEVE THIS COUNTY AND THIS 

6 PARTICULAR BOARD CARES AND IS BEING RESPONSIBLE AND THEY HAVE 

7 NO INTEREST OF COMING DOWN BECAUSE THEY SEE THE WAY MANY OF US 

8 ARE DISRESPECTED IN COMING AND SPEAKING BEFORE YOU AND HOW YOU 

9 DON'T FOLLOW THROUGH. THERE'S NEVER BEEN A TIME HERE THAT 

10 YOU'VE ACTUALLY RESPONDED AND HAS SAID, "YOU KNOW, WARREN, 

11 THAT MAKES SENSE, WE ACKNOWLEDGE WHAT YOU HAVE SAID AND WE'RE 

12 GOING TO ACT UPON YOUR RECOMMENDATION." IT'S NEVER HAPPENED. I 

13 HAVE RECEIVED A LETTER FROM YOU, ANTONOVICH, IN REGARD TO THE 

14 MEN'S COMMISSION AND I COMMEND YOU FOR THAT BUT IT'S STILL AN 

15 UNRESOLVED ISSUE. WE DON'T HAVE IT. AN AGENDA BIASED SYSTEM, 

16 WE DO NEED A MEN'S COMMISSION. AND SUPERVISOR BURKE, I HAVE 

17 RECEIVED A LETTER FROM YOU AND I COMMEND YOU FOR THAT, 

18 SUPPORTING MY VIEWS DEALING WITH OUR CHILDREN, IN BOTH YOUR 

19 DISTRICT AND THE DISTRICT OF L.A. HOWEVER, OUR CHILDREN ARE 

20 STILL SUFFERING THESE PROBLEMS. THIS GOES WAY BACK BUT, IF WE 

21 GO BACK TO JUST THE PROGRAM FUNDED 90044, THAT WAS ALMOST TWO 

22 DECADES AGO AND YET THE SAME PROBLEM STILL EXISTS IN AREAS 

23 LIKE SOUTH CENTRAL, NEW SOUTH CENTRAL, COMPTON, AND SO ON AND 

24 SO FORTH. PEOPLE WHO HAVE LITTLE INCOME WHO ARE SUBJECTED TO 

25 HOMELESS CONDITIONS OR OTHER ARE MORE LIKELY TO END UP IN THE 
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1 SYSTEM BECAUSE THEY HAVE NO FORMIDABLE DEFENSE AGAINST BEING 

2 ATTACKED. THE FINAL ISSUES, THE CRISES IS NUMBER 41, OF 

3 EMERGENCY COUNSELING AND THINGS FOR THE EVACUEES FROM KATRINA. 

4 WELL, HOW DO WE NOT END UP CONTINUING TO PRETEND THAT F.E.M.A. 

5 DOESN'T EXIST WHEN THAT'S F.E.M.A.'S RESPONSIBILITY? WHAT IS 

6 THE COUNTY DOING MAKING SURE FIRST THAT F.E.M.A. IS DOING ITS 

7 JOB, BECAUSE A LOT OF PEOPLE HERE IN L.A. COUNTY NEEDS THOSE 

8 FUNDS. THE REGIONAL FOOD BANK ANNOUNCED THAT A LOT OF PEOPLE 

9 THAT WERE SHORT ON TURKEYS AND THINGS THIS YEAR, A LOT OF 

10 PEOPLE ON THE STREET ARE COMPLAINING TO ME THAT THEIR NEEDS 

11 ARE NOT BEING MET, EVEN DURING THIS HOLIDAY PERIOD. BUT, YET, 

12 WHEN THEY CREATE SOMETHING LIKE KATRINA, THEN ALL OF THESE 

13 ENTITIES ALL OF A SUDDEN ALL FOCUS ON THAT ONE THING AND THEY 

14 NEGLECT PEOPLE THAT'S ALREADY BEEN NEGLECTED TOO LONG. SO, 

15 AGAIN, WE WOULD LIKE A WRITTEN RESPONSE ON ALL OF THESE ITEMS. 

16 THANK YOU. 

17

18 SUP. ANTONOVICH: THANK YOU. 

19

20 YVONNE MICHELLE AUTRY: THANK YOU. 

21

22 SUP. ANTONOVICH: SUPERVISOR YAROSLAVSKY. 

23

24 SUP. YAROSLAVSKY: MOVE FOR APPROVAL OF THOSE ITEMS, 18 AND 85-

25 A. 
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1

2 WARREN WILLIAMS: OH AND IF I MAY, I WANT TO ASK FOR 

3 RECONSIDERATION TO BE SURE THAT THE WEIGHT OF THAT HOLDS AND 

4 THAT MY OPPOSITION IS FILED ON THE RECORD. 

5

6 SUP. YAROSLAVSKY: I MOVE APPROVAL OF 18 AND 85-A. 

7

8 SUP. ANTONOVICH: MOTIONED BY YAROSLAVSKY. SECONDED. WITHOUT 

9 OBJECTION, SO ORDERED. 

10

11 SUP. YAROSLAVSKY: ITEM 79. 

12

13 SUP. ANTONOVICH: 79. THIS IS 85. 79. 79? 

14

15 SUP. YAROSLAVSKY: IT WAS HELD FOR A MEMBER OF THE PUBLIC. 

16

17 SUP. ANTONOVICH: PETER BAXTER. 

18

19 PETER BAXTER: MR. CHAIRMAN, MEMBERS OF YOUR HONORABLE BOARD, 

20 MR. JANSSEN, LADIES AND GENTLEMEN, MY NAME IS PETER BAXTER AND 

21 I LIVE IN LOS ANGELES. IT IS RESPECTFULLY SUBMITTED THAT THIS 

22 AGENDA ITEM REFERS TO THE PROPOSED INCREASE OF A PORTION OF 

23 THE FILING FEES WHICH ARE CHARGED FOR FILLING-- FILING CIVIL 

24 LAWSUITS, WHICH FEES, IN PART, PAY THE EXPENSES OF THE LAW 

25 LIBRARY. THIS IS A MANDATE. IT IS EITHER PAY THE FILING FEE OR 
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1 YOU FAIL TO OBTAIN THE SERVICES OF THE COURT. HOWEVER, IN THE 

2 INSTANCE OF THE COURT IN THE ANTELOPE VALLEY, THAT COURTHOUSE 

3 IS NAMED THE MICHAEL D. ANTONOVICH COURTHOUSE. THAT GIVES 

4 PUBLIC NOTICE THAT A DIFFERENT SET OF MAXIMS OR OF CANONS OF 

5 UNIVERSAL PRINCIPLES APPLY IN THAT SPECIFIC COURTHOUSE. THE 

6 JUDGES IN THE ANTELOPE VALLEY ARE WILLING, APPARENTLY, TO 

7 PRESIDE OVER CASES IN A COURT WHICH IS NAMED FOR A PROMINENT 

8 LOCAL POLITICIAN AND, EVEN THIS MORNING, THE HEADLINES SPEAK 

9 ABOUT A POLITICIAN IN SAN DIEGO. THE JUDGES IN THE ANTELOPE 

10 VALLEY ARE WILLING, APPARENTLY, TO PRESIDE OVER CASES IN A 

11 COURT WHICH IS NAMED FOR A PROMINENT LOCAL POLITICIAN. WHAT 

12 ELSE ARE THEY WILLING TO DO? DO THEY ACCEPT TELEPHONE CALLS 

13 FROM THE POLITICIAN WHOSE NAME IS ABOVE THE ENTRANCE IN THAT 

14 COURTHOUSE ON MATTERS WHICH ARE BEFORE THE COURT? WELL, DO 

15 THEY OR DON'T THEY? WHAT ARE THE IMPLICATIONS IN HAVING A 

16 COURTHOUSE NAMED FOR A SITTING POLITICIAN? WE'RE NOT TALKING 

17 ABOUT SOMEBODY WHO IS DEAD, WE'RE TALKING ABOUT A SITTING 

18 POLITICIAN AND A VERY PROMINENT POLITICIAN IN THE COUNTY AND 

19 IN THE STATE. IS THAT FACT SIGNIFICANT IN RAISING FUNDS FOR 

20 THAT POLITICIAN? IF THAT POLITICIAN, WHEN HE PRESENTS HIS 

21 CAMPAIGN, IS ABLE TO SAY HIS NAME IS ABOVE A COURTHOUSE, THAT 

22 IS IMPRESSIVE. THAT IS REALLY IMPRESSIVE. WHEN YOU CAN GET 

23 YOUR NAME ABOVE A COURTHOUSE, THAT'S A LITTLE MORE IMPORTANT 

24 THAN HAVING YOUR NAME ABOVE A BANK. BUT IF YOUR NAME IS ABOVE 

25 A BANK, YOU TELL THE PEOPLE IN THAT BANK WHAT TO DO. AND, IF 



November 29, 2005

45

1 YOUR NAME IS ABOVE A COURTHOUSE, HOW ARE WE TO KNOW THAT THIS 

2 PARTICULAR POLITICIAN IS NOT TELLING THE JUDGES WHAT TO DO? 

3 THE QUESTION REMAINS, IS IT LAWFULLY ACCEPTABLE FOR THE LAW 

4 LIBRARY TO REQUEST A PORTION OF FILING FEES, BECAUSE THEY 

5 OUGHT TO KNOW, IF ANYBODY DOES, ABOUT THE SITUATION, TO 

6 REQUEST A PORTION OF FILING FEES TO BE CHARGED TO LITIGANTS 

7 WHEN ALL SEVEN COUNTY OFFICERS, BEING THE BOARD OF THE LAW 

8 LIBRARY TRUSTEES, ARE OF A PERSONAL AND PROFESSIONAL VIEW? FOR 

9 ALL WE KNOW, THAT THE ANTELOPE COURTHOUSE MAY BE NAMED FOR A 

10 COUNTY SUPERVISOR, IT MAY BE NAMED UNLAWFULLY. AND I THANK 

11 YOU, MR. CHAIRMAN. 

12

13 SUP. ANTONOVICH: THANK YOU. MOTION BEFORE US IS THE L.A. 

14 COUNTY LAW LIBRARY RECOMMENDATION. 

15

16 SUP. YAROSLAVSKY: MOVE APPROVAL. 

17

18 SUP. ANTONOVICH: YAROSLAVSKY. SECONDED. WITHOUT OBJECTION, SO 

19 ORDERED. 

20

21 SUP. YAROSLAVSKY: MR. CHAIRMAN, THERE WAS ONE OTHER PERSON ON 

22 ON 85-A WHO WANTED TO BE HEARD, SO I'M GOING TO MOVE 

23 RECONSIDERATION OF 85-A. I THINK JOEL ROBERTS WANTED TO SPEAK 

24 IN FAVOR OF IT. 

25
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1 SUP. ANTONOVICH: HOW ARE YOU? 

2

3 JOEL ROBERTS: FINE, THANK YOU. GOOD MORNING. I AM THE C.E.O. 

4 OF P.A.T.H., PEOPLE ASSISTING THE HOMELESS. WE ARE ORGANIZING 

5 THE PROJECT Y!IMBY CONNECT DAY, ALONG WITH THE COUNTY OF LOS 

6 ANGELES AND WE'RE JUST VERY GRATEFUL FOR PROCLAIMING DECEMBER 

7 8TH AS PROJECT HOMELESS CONNECT DAY. AS YOU KNOW, THE PUBLIC 

8 AND THE MEDIA ARE ONCE AGAIN DISCUSSING THE ISSUE OF 

9 HOMELESSNESS IN OUR COMMUNITIES AND WE'RE JUST THANKFUL THAT 

10 THE COUNTY OF LOS ANGELES IS TAKING THE LEADERSHIP TO ADDRESS 

11 THE PLIGHT OF MANY OF OUR CITIZENS WHO LIVE ON OUR STREETS. 

12 YOUR LEADERSHIP IN INVESTING MORE MONEY INTO HOMELESS 

13 SERVICES, IN GUIDING THE CURRENT TEN-YEAR PLAN TO END 

14 HOMELESSNESS AND NOW BACKING PROJECT Y!IMBY CONNECT DAY, WHICH 

15 MEANS YES! IN MY BACKYARD, IS COMMENDABLE. PROJECT Y!IMBY IS 

16 PART OF THE SOLUTION TO ENDING HOMELESSNESS IN LOS ANGELES 

17 COUNTY. IT IS A MODEL TO MOBILIZE LOCAL COMMUNITIES THROUGHOUT 

18 THE COUNTY TO USE THEIR OWN RESOURCES TO ADDRESS HOMELESSNESS 

19 ON A LOCAL LEVEL. IT IS A MODEL WHERE WE CONNECT PEOPLE WHO 

20 ARE HOMELESS INTO SERVICES AND HOUSING AND WE USE THE LOCAL 

21 COMMUNITY THROUGHOUT THE COUNTY AND SO WE HOPE THAT 

22 COMMUNITIES THROUGHOUT THE COUNTY WILL USE PROJECT Y!IMBY TO 

23 ADDRESS HOMELESSNESS IN THEIR LOCAL COMMUNITY. SO I'M VERY 

24 THANKFUL FOR YOUR LEADERSHIP IN HELPING TO ADDRESS 

25 HOMELESSNESS IN LOS ANGELES COUNTY. THANK YOU VERY MUCH. 
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1

2 SUP. ANTONOVICH: THANK YOU, JOEL. ALSO, YVONNE AUTRY. 

3

4 SUP. YAROSLAVSKY: SHE ALREADY SPOKE ON IT. THANK YOU, JOEL, 

5 FOR YOUR SUPPORT. I MOVE APPROVAL. 

6

7 SUP. ANTONOVICH: MOVED. YAROSLAVSKY SECONDED. WITHOUT 

8 OBJECTION, SO ORDERED. 

9

10 SUP. YAROSLAVSKY: MR. CHAIRMAN, ITEM 82. 

11

12 CLERK ROBIN GUERRERO: THESE ARE PUBLIC HEARING ITEMS. IS THERE 

13 ANYBODY IN THE AUDIENCE WHO IS PRESENT TO BE HEARD ON THESE 

14 ITEMS, 82, 83, AND 84, TO BE SWORN IN? SUPERVISOR ANTONOVICH? 

15

16 SUP. YAROSLAVSKY: OKAY. I'LL MOVE APPROVAL. 

17

18 CLERK ROBIN GUERRERO: I NEED TO READ SOMETHING INTO THE 

19 RECORD. 

20

21 SUP. YAROSLAVSKY: OH, I'M SORRY. 

22

23 CLERK ROBIN GUERRERO: SUPERVISORS, THERE WERE NO BALLOTS 

24 RECEIVED. IT WOULD BE APPROPRIATE TO CLOSE THE HEARING AND 

25 MAKE A DETERMINATION THAT NO MAJORITY PROTEST EXISTS AGAINST 
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1 THE PROPOSED ANNEXATION AND LEVYING OF ASSESSMENTS FOR 

2 TERRITORY PETITION NUMBER 29-200 WITHIN THE COUNTY LIGHTING 

3 MAINTENANCE DISTRICT 1687 AND COUNTY LIGHTING DISTRICT LLA-1 

4 FOR THE UNINCORPORATED ZONE SANTA FE SPRINGS AREA. AS A 

5 RESULT, IT WOULD BE APPROPRIATE FOR THE BOARD TO ADOPT THE 

6 RESOLUTION TO ANNEX AND LEVY ASSESSMENTS FOR PETITION NUMBER 

7 29-200 WITHIN THE COUNTY LIGHTING MAINTENANCE DISTRICT 1687 

8 AND COUNTY LIGHTING DISTRICT LLA-1 FOR THE UNINCORPORATED ZONE 

9 SANTA FE SPRINGS AREA AND ACCEPT THE EXCHANGE OF NEGOTIATED 

10 PROPERTY TAX REVENUES RESULTING FROM THE ANNEXATION. 

11

12 SUP. ANTONOVICH: MOTION BY YAROSLAVSKY TO CLOSE THE HEARING 

13 AND APPROVE THE ITEM 

14

15 SUP. YAROSLAVSKY: SO MOVED. 

16

17 SUP. ANTONOVICH: WITHOUT OBJECTION? 

18

19 RICHARD WEISS, COUNSEL: TECHNICALLY, MR. MAYOR, THERE IS A 

20 BRIEF STAFF STATEMENT THAT MUST BE PUT INTO THE RECORD, IF WE 

21 COULD DO THAT. 

22

23 SUP. YAROSLAVSKY: OKAY. HAVE STAFF MAKE A BRIEF STATEMENT. 

24
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1 RANDINE RUIZ: MY NAME IS RANDINE RUIZ. I'M A SENIOR CIVIL 

2 ENGINEER FOR THE DEPARTMENT OF PUBLIC WORKS. I'M FAMILIAR WITH 

3 THESE PROCEEDINGS FOR THE ANNEXATION OF PROPERTY IN THE SANTA 

4 FE SPRINGS AREA COVERED BY PETITION NUMBER 29-200. 

5

6 SUP. ANTONOVICH: YOUR MICROPHONE IS NOT ON. 

7

8 RANDINE RUIZ: TO LIGHTING MAINTENANCE DISTRICT-- OKAY. TO 

9 LIGHTING MAINTENANCE DISTRICT 1687 AND COUNTY LIGHTING 

10 DISTRICT LLA-1 UNINCORPORATED ZONE AND FOR THE LEVYING AND 

11 COLLECTION OF ASSESSMENTS WITHIN THE PETITION AREA. NONE OF 

12 THE AREA TO BE ANNEXED LIES WITHIN THE BOUNDARIES OF ANY CITY. 

13 IN MY OPINION, THE INVOLVED AREA WILL BE BENEFITED BY THE 

14 ANNEXATION AND THE SERVICE TO BE PROVIDED AND THE PROPOSED 

15 ASSESSMENTS HAVE BEEN SPREAD IN PROPORTION TO BENEFIT. IN THE 

16 EVENT THAT THERE'S NO MAJORITY PROTEST, WE ARE RECOMMENDING 

17 THAT YOUR BOARD ADOPT THE RECOMMENDATION TO ANNEX AND LEVY THE 

18 PROPOSED ASSESSMENTS AND THAT YOU APPROVE AND ACCEPT THE 

19 EXCHANGE OF PROPERTY TAX REVENUES FROM THE AFFECTED TAXING 

20 AGENCIES AS IDENTIFIED IN THE BOARD LETTER. 

21

22 SUP. ANTONOVICH: MOTION BY YAROSLAVSKY TO CLOSE THE HEARING 

23 AND APPROVE THE ITEM. SECONDED. WITHOUT OBJECTION, SO ORDERED. 

24

25 SUP. YAROSLAVSKY: ITEM 83. 
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1

2 CLERK ROBIN GUERRERO: SUPERVISORS, THERE WERE NO-- DO WE HAVE 

3 A STAFF STATEMENT? 

4

5 RANDINE RUIZ: YES, WE DO. MY NAME IS RANDINE RUIZ AND I AM A 

6 SENIOR CIVIL ENGINEER FOR THE DEPARTMENT OF PUBLIC WORKS. I AM 

7 FAMILIAR WITH THESE PROCEEDINGS FOR THE ANNEXATION OF PROPERTY 

8 IN THE GORMAN AREA COVERED BY PETITION NUMBER 132-49 TO 

9 LIGHTING MAINTENANCE DISTRICT 1687 AND COUNTY LIGHTING 

10 DISTRICT LLA-1 UNINCORPORATED ZONE AND FOR THE LEVYING AND 

11 COLLECTION OF ASSESSMENTS WITHIN THE PETITION AREA. NONE OF 

12 THE AREA TO BE ANNEXED LIES WITHIN THE BOUNDARIES OF ANY CITY. 

13 IN MY OPINION, THE INVOLVED AREA WILL BE BENEFITED BY THE 

14 ANNEXATION AND THE SERVICE TO BE PROVIDED AND THE PROPOSED 

15 ASSESSMENTS HAVE BEEN SPREAD IN PROPORTION TO BENEFIT. IN THE 

16 EVENT THAT THERE IS NO MAJORITY PROTEST, WE ARE RECOMMENDING 

17 THAT YOUR BOARD ADOPT THE RECOMMENDATION TO ANNEX AND LEVY THE 

18 PROPOSED ASSESSMENTS AND THAT YOU APPROVE AND ACCEPT THE 

19 EXCHANGE OF PROPERTY TAX REVENUES FOR THE AFFECTED TAXING 

20 AGENCIES AS IDENTIFIED IN THE BOARD LETTER. 

21

22 CLERK ROBIN GUERRERO: SUPERVISORS, THERE WERE NO BALLOTS 

23 RECEIVED. IT WOULD BE APPROPRIATE TO CLOSE THE HEARING AND 

24 MAKE A DETERMINATION THAT NO MAJORITY PROTEST EXISTS AGAINST 

25 THE PROPOSED ANNEXATION AND LEVYING OF ASSESSMENTS FOR 
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1 TERRITORY PETITION NUMBER 132-49 WITHIN THE COUNTY LIGHTING 

2 MAINTENANCE DISTRICT 1687 AND COUNTY LIGHTING DISTRICT LLA-1 

3 FOR THE UNINCORPORATED ZONE GORMAN AREA. AS A RESULT, IT WOULD 

4 BE APPROPRIATE FOR THE BOARD TO ADOPT THE RESOLUTION TO ANNEX 

5 AND LEVY ASSESSMENTS FOR PETITION NUMBER 132-49 WITHIN THE 

6 COUNTY LIGHTING MAINTENANCE DISTRICT 1687 AND COUNTY LIGHTING 

7 DISTRICT LLA-1 FOR THE UNINCORPORATED ZONE GORMAN AREA AND 

8 ACCEPT THE NEGOTIATED EXCHANGE OF PROPERTY TAX REVENUES 

9 RESULTING FROM THE ANNEXATION. 

10

11 SUP. ANTONOVICH: OKAY. MOTION BY YAROSLAVSKY TO CLOSE THE 

12 HEARING AND APPROVE THE ITEM. SECONDED. WITHOUT OBJECTION, SO 

13 ORDERED. 

14

15 SUP. YAROSLAVSKY: ITEM NUMBER 84. 

16

17 CLERK ROBIN GUERRERO: ITEM 84 IS A HEARING ON PROPOSED 

18 AMENDMENTS TO THE COUNTY CODE TITLE 2 ADMINISTRATION TO 

19 CONTINUE AUTHORITY TO ASSESS COMMERCIAL WEIGHING AND MEASURING 

20 DEVICE REGISTRATION FEES AND INCREASE THESE FEES TO THE 

21 MAXIMUM LEVEL AND TO ESTABLISH A NEW FEE TO RECOVER COSTS OF 

22 REINSPECTION OF ANY STORE AT WHICH THE DEPARTMENT OF WEIGHTS 

23 AND MEASURES INSPECTORS HAD DISCOVERED OVERCHARGE VIOLATIONS 

24 DURING A PRIOR STANDARD INSPECTION WITHIN THREE MONTHS, AS 

25 PROVIDED BY THE BUSINESS AND PROFESSIONS CODE AND AS AMENDED 
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1 BY ASSEMBLY BILL 889, TO BE EFFECTIVE JANUARY 1ST, 2006. WE 

2 HAVE NO WRITTEN PROTESTS AND NO ONE IS PRESENT TO BE HEARD, I 

3 BELIEVE. 

4

5 SUP. ANTONOVICH: OKAY. MOTION BY YAROSLAVSKY TO CLOSE THE 

6 HEARING AND APPROVE THE ITEM. SECONDED. WITHOUT OBJECTION, SO 

7 ORDERED. 

8

9 SUP. YAROSLAVSKY: THAT'S ALL I HAVE, MR. CHAIRMAN. 

10

11 SUP. ANTONOVICH: SUPERVISOR KNABE? 

12

13 SUP. KNABE: MR. CHAIRMAN, A NUMBER OF ADJOURNMENTS THIS 

14 MORNING. FIRST OF ALL, THAT WE ADJOURN IN MEMORY OF JULIA 

15 IBBETSON ZILINSKAS. JULIA PASSED AWAY ON NOVEMBER 27TH. SHE 

16 WAS CHAIRMAN OF THE Y.M.C.A. GREATER LONG BEACH BOARD OF 

17 DIRECTORS FROM 2000-2003 AND LED THE ASSOCIATION THROUGH A 

18 VERY SIGNIFICANT TRANSITION TIME. SHE WAS ALSO BOARD CHAIR FOR 

19 THE LOS CERRITOS BRANCH. SHE WAS VERY INVOLVED IN THE Y.M.C.A. 

20 BUT, MORE IMPORTANTLY, SHE IS SURVIVED BY HER HUSBAND, MARTIN, 

21 AND MOTHER, HARRIET IBBETSON. SHE IS THE DAUGHTER OF IVY 

22 IBBETSON, WHO PASSED AWAY JUST LESS THAN A YEAR AGO. JULIA AND 

23 HER FAMILY ARE DEAR FRIENDS OF JULIE AND I AND SHE WILL BE 

24 GREATLY MISSED BY ALL. ALSO THAT WE ADJOURN IN MEMORY OF JEAN 

25 VAN NOSTRAN, WHO PASSED AWAY ON NOVEMBER 22ND. SHE DIED OF A 
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1 STREP THROAT-RELATED ILLNESS THAT WENT INTO A VERY SIGNIFICANT 

2 STAPH INFECTION. SHE WAS THE WIFE OF LAKEWOOD VICE-MAYOR LARRY 

3 VAN NOSTRAN AND THEY HAD BEEN MARRIED FOR 54 YEARS. JEAN AND 

4 LARRY MOVED TO LAKEWOOD IN 1958 AND STILL LIVE IN THE SAME 

5 HOUSE THEY PURCHASED BACK THEN. SHE WAS VERY ACTIVE IN VARIOUS 

6 CIVIC AND CHURCH WORK AND MADE IT HER BUSINESS TO CARE ABOUT 

7 OTHERS. SHE WAS WELL KNOWN FOR HER TERRIFIC HUGS AND HER BIG 

8 SMILE THAT SHE GAVE OUT EVERY SUNDAY MORNING AND THROUGHOUT 

9 THE CITY AT CHRIST PRESBYTERIAN CHURCH. SHE IS SURVIVED BY HER 

10 HUSBAND, LARRY, SONS, DENNIS AND DAVID, GRANDCHILDREN MICHAEL, 

11 MARK, RICHARD, PAUL, AND STEPHANIE AND FIVE GREAT-

12 GRANDCHILDREN. SHE WILL BE MISS BY ALL. IT WAS VERY SUDDEN. 

13 ALSO THAT WE ADJOURN TODAY IN MEMORY OF JON GIVENS, WHO WAS 

14 BRUTALLY MURDERED ON NOVEMBER 17TH, AN INNOCENT VICTIM OF TWO 

15 GUNSHOT WOUNDS TO THE CHEST. HE IS THE SON OF JERRY GIVENS, 

16 WHO WAS BRUTALLY MURDERED ON NOVEMBER 17TH, AN INNOCENT VICTIM 

17 OF TWO GUNSHOT WOUNDS TO THE CHEST. HE IS THE SON OF JERRY 

18 GIVENS, THE DIRECTOR OF PUBLIC WORKS FOR THE CITY OF 

19 INGLEWOOD. JERRY, YOU MAY REMEMBER, WAS-- USED TO WORK FOR THE 

20 L.A. C.T.C. AND THAT'S HIS DAD AND JERRY WAS VERY INVOLVED IN 

21 OVERSEEING THE CONSTRUCTION OF THE GREEN LINE, BLUE LINE AND 

22 RED LINE. HE IS SURVIVED BY HIS FATHER, JERRY, HIS MOTHER AND 

23 HIS TWO DAUGHTERS. 

24

25 SUP. ANTONOVICH: ALL MEMBERS. 
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1

2 SUP. KNABE: ALSO MOVE THAT WE ADJOURN IN MEMORY OF WANDA 

3 CATRON, WHO PASSED AWAY ON NOVEMBER 6TH, FOLLOWING A LONG 

4 ILLNESS. SHE IS SURVIVED BY HER SON, DENNIS. ALSO WE ADJOURN 

5 IN MEMORY OF DARLENE "DOTTIE" STEVENS, WHO PASSED AWAY AT THE 

6 AGE OF 77. SHE WAS A RESIDENT OF LAKEWOOD AND SHE WORKED FOR 

7 MANY YEARS WITH DOLLY MADISON. SHE IS SURVIVED BY HER 

8 DAUGHTER, SANDRA, SON, GARY AND SISTERS, LINDA AND THREE 

9 GRANDCHILDREN AND MANY STEPDAUGHTERS AND FOUR STEP 

10 GRANDCHILDREN AND 17 GREAT- GRANDCHILDREN. SHE WAS PRECEDED IN 

11 DEATH BY HER HUSBAND, DONALD. ALSO THAT WE ADJOURN IN MEMORY 

12 OF MABEL EDNA BLOOMFIELD, WHO PASSED AWAY ON NOVEMBER 21ST AT 

13 THE AGE OF 95. MABEL IS A STRONG SUPPORTER OF CERRITOS COLLEGE 

14 AND THE BLOOMFIELD PHILOSOPHY SCHOLARSHIP FOR THE COLLEGE. SHE 

15 IS SURVIVED BY HER SON, ED AND GRANDDAUGHTER, VERONICA. THOSE 

16 ARE MY ADJOURNMENTS. 

17

18 SUP. ANTONOVICH: OKAY. SECONDED. WITHOUT OBJECTION, SO 

19 ORDERED. 

20

21 SUP. KNABE: HOW ABOUT ITEM-- WELL, THOSE ARE YOUR ITEMS. NEVER 

22 MIND. I DON'T HAVE ANY. I DIDN'T HOLD ANYTHING. THANK YOU. 

23

24 SUP. ANTONOVICH: LET ME MOVE THAT TODAY WE ADJOURN IN MEMORY 

25 OF RAY CONSIDINE. RAY WAS MY COMMISSIONER ON THE COUNTY 
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1 EFFICIENCY COMMISSION WHO DIED UNEXPECTEDLY TWO DAYS AGO. RAY 

2 WAS A-- MANY OF YOU HEARD THE PHRASE, "SOLVE IT BY STEPPING 

3 OUT OF THE BOX TO FIND THE SOLUTION." HE WAS THE PERSON WHO 

4 ORIGINATED THAT PHRASE AND WAS A BEST SELLING AUTHOR, HAD 

5 WRITTEN A NUMBER OF BOOKS, INCLUDING "THE GREAT BRAIN ROBBERY" 

6 AND "HOW TO STEAL IDEAS AND MAKE MORE MONEY" WITH A LITTLE 

7 TWIST. HE WAS THE PRESIDENT OF CONSIDINE AND ASSOCIATES BASED 

8 IN PASADENA. HE TAUGHT AT UNIVERSITY OF SOUTHERN CALIFORNIA, 

9 UNIVERSITY OF CALIFORNIA AT LOS ANGELES, CLAREMONT COLLEGE. HE 

10 ALSO WAS QUITE ACTIVE IN ALTADENA, PRESIDENT OF THE SHERIFF'S 

11 SUPPORT GROUP OF ALTADENA, CHAIRMAN OF THE PASADENA CITIZEN'S 

12 POLICE ACADEMY AND SERVED, AS I SAID, AS MY APPOINTEE TO THE 

13 L.A. COUNTY CITIZENS ECONOMY AND EFFICIENCY COMMITTEE. HE HAD 

14 BEEN FORMALLY EXECUTIVE VICE PRESIDENT OF KRUPP INDUSTRIES, 

15 THE PREMIERE WEST COAST DIRECT MARKETING DIRECT FIRM. A REAL 

16 GOOD COMMUNITY, I ENCOURAGE THOSE OF YOU WHO LIKE READING WITH 

17 A TWIST ON HOW TO IMPROVE EFFICIENCY TO READ SOME OF HIS 

18 BOOKS. ELVERA BROWN THOMAS, WHO PASSED AWAY SUNDAY AT HER HOME 

19 IN THE ANTELOPE VALLEY AT 107 YEARS OF AGE. SHE MOVED THERE IN 

20 THE EARLY 1950S. SHE HELPED START THE WHOSOEVER WILL CHRISTIAN 

21 CHURCH IN PALMDALE, INSTRUMENTAL IN RAISING MANY FOSTER 

22 CHILDREN AND WE ADJOURN IN HER MEMORY. AMBASSADOR ROBERT DEAN 

23 NESEN, FORMER AMBASSADOR TO AUSTRALIA DURING THE FIRST TERM OF 

24 PRESIDENT RONALD REAGAN'S ADMINISTRATION AND ALSO FORMER 

25 ASSISTANT NAVY SECRETARY UNDER PRESIDENT RICHARD NIXON. HE WAS 
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1 A NAVY PILOT DURING WORLD WAR II AND HE WAS NAMED TO THE STATE 

2 BOARD OF EDUCATION WHEN GOVERNOR REAGAN WAS GOVERNOR, AND 

3 LATER AS PRESIDENT, AS I SAID, APPOINTED HIM TO AMBASSADOR OF 

4 AUSTRALIA. HE LEAVES HIS WIFE AND TWO SONS, FIVE 

5 GRANDCHILDREN, AND FOUR GREAT-GRANDCHILDREN. I HAD THE 

6 OPPORTUNITY TO WORK WITH BOB IN THE REAGAN-- WHEN REAGAN WAS 

7 GOVERNOR AND THEN LATER WHEN HE WAS PRESIDENT, AND QUITE 

8 ACTIVE IN THE VENTURA COUNTY AREA AND A VERY GOOD MAN. PAT 

9 MORITA, THE ACTOR, WHO PASSED AWAY AT THE AGE OF 73. PAT WAS 

10 INVOLVED IN THE COMMUNITY AND ALSO WAS FAMOUS FOR MANY OF HIS 

11 MOVIES. HE WAS THE VOICE IN "MULAN," THE DISNEY FILM, ALONG 

12 WITH "THE KARATE KID," "SPY HARD," " HONEYMOON IN LAS VEGAS," 

13 AND "COLLISION COURSE," AMONG OTHERS. HE PARTICIPATED IN SOME 

14 OF THE EVENTS AT NISEI WEEK AND SENSEI WEEK IN J-TOWN AND FOR 

15 THE COMMUNITY AND PASSED AWAY THIS WEEK. RICHARD LAWYER, WHO 

16 WAS A TEST PILOT, ASTRONAUT-SELECT AND FLIGHT INSTRUCTOR. HE 

17 PASSED AWAY AT HIS HOME IN PALMDALE. CRAIG AUSTIN CALDWELL, 

18 LONG-TIME RESIDENT OF LAKE HUGHES AND LAKE ELIZABETH. HE OWNED 

19 THE SPA SHOP IN THE AREA AND HE PASSED AWAY AT THE AGE OF 45. 

20 STANLEY HAHN, WHO PASSED AWAY AT THE AGE OF 95, FORMER 

21 PRESIDENT OF TOURNAMENT OF ROSES, SERVED AS A MEMBER OF THE 

22 BOARD OF THE PASADENA Y.M.C.A., QUITE ACTIVE IN THE PASADENA 

23 SAN GABRIEL VALLEY. AND STANLEY HAHN, WHO WAS A PRACTICING 

24 ATTORNEY IN THE PASADENA, WAS ALSO, AS I SAID, THE FORMER 

25 PRESIDENT OF THE TOURNAMENT OF ROSES. SECONDED BY KNABE. 
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1 WITHOUT OBJECTION, SO ORDERED. AND I'D LIKE TO INTRODUCE THIS 

2 MOTION FOR NEXT WEEK. YOU KNOW, BACK IN DECEMBER, 2001, OUR 

3 BOARD APPROVED MY MOTION REQUESTING THE DEPARTMENT OF MENTAL 

4 HEALTH TO ACCELERATE THE INFRASTRUCTURE PLANS TO ENHANCE 

5 COUNTYWIDE HOMELESS SERVICES. SINCE THAT TIME, THE DEPARTMENT 

6 OF MENTAL HEALTH HAS BEEN WORKING TO ADDRESS MENTALLY ILL 

7 HOMELESS HOUSING ISSUES AND ACCESS TO RESOURCES. WITH THE 

8 PENDING IMPLEMENTATION OF THE MENTAL HEALTH SERVICES ACT, THE 

9 FUTURE CONTINUES TO LOOK BRIGHTER FOR THOSE REQUIRING HOUSING 

10 ASSISTANCE IN OUR COUNTY. IN ADDITION, THE DEPARTMENT OF 

11 HEALTH SERVICES HAS WORKED TO ADDRESS SIMILAR ISSUES AND HAS 

12 DRAFTED A TITLE-- REPORT TITLED, THE HOMELESS SERVICE ACTION 

13 PLAN, THAT ADDRESSES RECOMMENDATION PROTOCOLS IN COOPERATION 

14 AMONG COUNTY AGENCIES TO COORDINATE ACCESS TO SOCIAL SERVICES 

15 THROUGHOUT THE COUNTY. THE HOMELESS SERVICE TASK FORCE HAS 

16 ALSO BEEN WORKING TO ADDRESS HOMELESS SERVICE OUTREACH WITHIN 

17 THE COMMUNITY OF SKID ROW. HOWEVER, THERE REMAINS SEVERAL 

18 FACTORS RELATED TO THOSE THAT ARE EITHER ENTERING INTO THE 

19 SKID ROW AREA OR BEING BROUGHT TO THE AREA TO ACCESS SERVICES 

20 FROM THE COMMUNITY PROVIDERS WITHIN THE SKID ROW AREA AND 

21 DOWNTOWN LOS ANGELES CITY. THE RECENT NEWS ACCOUNTS REVEALED 

22 INAPPROPRIATE PATIENT DISCHARGES FROM THE KING/DREW MEDICAL 

23 CENTER, HOLLYWOOD PRESBYTERIAN HOSPITAL, KAISER HOSPITAL AND 

24 U.S.C. MEDICAL CENTER. AND TODAY I RECEIVED A FAX FROM A LADY 

25 IN CHARGE OF MENTAL HEALTH AND THE SUPPORT GROUPS IN SAN 
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1 FERNANDO VALLEY THAT HER DAUGHTER HAD HAD THE SAME PROBLEM 

2 OCCURRED FROM BEING RELEASED PREMATURELY, BEING RELEASED WITH 

3 NO PLACE TO GO, TAKEN DOWNTOWN BY CEDARS OF LEBANON HOSPITAL. 

4 BUT THESE ACTIONS ARE UNACCEPTABLE AND INAPPROPRIATE. ACTION 

5 NEEDS TO ESTABLISH COLLABORATION BETWEEN THE PUBLIC/PRIVATE 

6 SECTOR AND COUNTY AGENCIES IN ADDRESSING THIS CRITICAL NEED. 

7 SO I'D MOVE THAT THE BOARD DIRECT THE DEPARTMENT OF HEALTH 

8 SERVICES TO WORK IN COLLABORATION WITH THE CHIEF 

9 ADMINISTRATIVE OFFICE AND THE DEPARTMENT OF PUBLIC SOCIAL 

10 SERVICES TO-- AND THE DEPARTMENT OF MENTAL HEALTH AND THE 

11 SHERIFF'S DEPARTMENT TO MAKE THOSE RECOMMENDATIONS AND 

12 PROTOCOLS RELATED TO PATIENT DISCHARGES TO ENSURE THAT 

13 HOMELESS PATIENTS HAVE ACCESS TO SOCIAL SERVICES UPON THEIR 

14 DISCHARGE FROM A COUNTY HEALTH FACILITY, TO DETERMINE THE 

15 FEASIBILITY AND RESOURCES NECESSARY FOR AN ON-SITE DEPARTMENT 

16 OF PUBLIC SOCIAL SERVICE PILOT PROGRAM WHERE CASEWORKERS 

17 ADDRESS THE NEEDS OF HOMELESS INDIVIDUALS WHO RECEIVE 

18 TREATMENT AT L.A. COUNTY MEDICAL CENTERS AND TO REPORT ON THE 

19 STATUS AND IMPLEMENTATION OF THE HOMELESS SERVICE ACTION PLAN 

20 AS DEVELOPED IN JULY OF 2004, WITH QUARTERLY PROGRESS REPORTS 

21 TO THE BOARD ON STRENGTHENING HOMELESS SERVICES IN THE COUNTY 

22 HEALTH FACILITIES. THAT WOULD BE A MOTION AND FOR THAT, COULD 

23 WE PASS THAT TODAY? BECAUSE IT'S ASKING FOR... 

24
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1 RAYMOND G. FORTNER, JR.: YES, MR. MAYOR. IT'S ESSENTIALLY IN 

2 THE NATURE OF A REPORT BACK, SO YOU CAN ADOPT THAT TODAY. 

3

4 SUP. ANTONOVICH: SO I'LL MOVE IT, SECONDED BY BURKE. WITHOUT 

5 OBJECTION, SO ORDERED. ON ITEM NUMBER 1-H, IF WE COULD HAVE 

6 THE DEPARTMENT OF COMMUNITY DEVELOPMENTS. ALSO, WHILE THEY ARE 

7 COMING UP, LET ME ALSO MOVE THAT WE ADJOURN IN MEMORY OF JOHN 

8 EDWARD RICE. MANY OF YOU MAY HAVE SEEN JOHN AND HIS BROTHER ON 

9 TELEVISION AND, AS YOU KNOW, BILLY BARTY WAS A GOOD FRIEND OF 

10 OURS, GODFATHER TO MY CHILDREN AND SERVED AS MY COMMISSIONER 

11 ON THE DEVELOPMENTALLY DISABLED COMMISSION AND DID A LOT FOR 

12 LITTLE PEOPLE. JOHN RICE WAS BORN AND HE AND HIS WIFE-- AND 

13 BROTHER, I SHOULD SAY, WERE DWARF TWINS ABANDONED AT THE 

14 HOSPITAL BY THEIR PARENTS BUT ADOPTED BY A WONDERFUL COUPLE 

15 AND THEY GREW TO BE 2-FEET-10, 2 FEET, 10 INCHES AND WHAT 

16 THEY'RE ABLE TO DO IS VERY, VERY REMARKABLE AND A GOOD ROLE 

17 MODEL. THEY WERE ACTIVELY INVOLVED IN THE BOY SCOUTS, THEY 

18 CARRIED THEIR BACKPACKS AS ANY OTHER SCOUT AND THEY CONTINUED 

19 WITH THEIR LOVING FAMILY DOING WELL BUT THEN THE MOTHER DIED 

20 IN THE EIGHTH GRADE AND THE FATHER DIED WHEN THEY WERE IN THE 

21 TENTH GRADE. BUT THEY CAME INTO THE WORLD SMALL AND THEY WERE 

22 AN INSPIRATION. IN THEIR COUNTY, MIAMI, FLORIDA, THEY FLEW THE 

23 FLAGS AT HALF-MAST LAST WEEK BECAUSE THEY WERE SUCH AN 

24 INTEGRAL PART OF THE COUNTY. THEY WERE SUCCESSFUL, BECAME 

25 MULTIMILLIONAIRES IN REAL ESTATE AND MOTIVATIONAL PROGRAMS. 
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1 AND AGAIN, TWO FEET 10 INCHES AND THEY WERE ABLE TO OVERCOME 

2 ALL OF THESE PROBLEMS AND BE A SUCCESS AND SHOW HOW YOU COULD 

3 BECOME SUCCESSFUL BY ACHIEVING YOUR EDUCATION AND PURSUING 

4 YOUR DREAMS. AND HE DIED TRAGICALLY. HE HAD A BROKEN LEG. THEY 

5 TOOK HIM TO THE HOSPITAL, AND HE DIED WHEN THEY WERE GIVING 

6 HIM THE ANESTHESIA. THEY PROBABLY GAVE HIM, YOU KNOW, ENOUGH 

7 FOR A 6-FOOTER INSTEAD OF 2-FEET 10 INCHES, AND IT'S JUST 

8 INCREDIBLE THAT HE WAS BILLED AS SUCH A GIANT AND THE IMPACT 

9 HE SERVED ON THE, I BELIEVE, THE PLANNING COMMISSION FOR HIS 

10 COMMUNITY, JUST A GOOD ROLE MODEL. SO ALSO WE ADJOURN IN 

11 MEMORY OF HIM. SECONDED BY KNABE. WITHOUT OBJECTION, SO 

12 ORDERED. MY QUESTIONS ON THIS CONTRACT, HOW MANY POTENTIAL 

13 BIDDERS WERE NOTIFIED FOR THIS CONTRACT? 

14

15 CARLOS JACKSON: WE MAILED OUT-- I'M SORRY. 30 BIDDERS WERE 

16 NOTIFIED. IN ADDITION, WE WENT ON THE INTERNET AND NOTIFIED AN 

17 ADDITIONAL 10 BIDDERS ABOUT THE POTENTIAL FOR THIS CONTRACT. 

18

19 SUP. ANTONOVICH: SO HOW WAS THE INFORMATION ABOUT THE CONTRACT 

20 POSTED ON THE COUNTY'S WEBSITE? 

21

22 CARLOS JACKSON: WE POSTED IT, AS REQUIRED, FOR THE MINIMUM OF 

23 15 DAYS. AS WELL, WE PUBLISH IN NINE NEWSPAPERS, COMMUNITY 

24 NEWSPAPERS. 

25
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1 SUP. ANTONOVICH: AND HOW MANY BIDDERS ATTEND THE PRE-BIDDERS 

2 CONFERENCE? 

3

4 CARLOS JACKSON: WE HAD SIX ATTEND THE PRE-BID CONFERENCE. 

5

6 SUP. ANTONOVICH: AND HOW MANY PROPOSALS DID YOU RECEIVE? 

7

8 CARLOS JACKSON: WE RECEIVED ONE. 

9

10 SUP. ANTONOVICH: DID C.D.C. STAFF INTERVIEW THE VENDORS WHO 

11 ATTENDED AND DID NOT, YOU KNOW, SUBMIT... 

12

13 CARLOS JACKSON: WE WERE ABLE TO CONTACT FOUR OF THE FIVE WHO 

14 DIDN'T SUBMIT BIDS AND THEY HAD VARIOUS REASONS AS TO WHY THEY 

15 DIDN'T SUBMIT BIDS. PART OF IT IS THAT THEY FELT THAT OUR 

16 CONTRACT WAS TOO CUMBERSOME. ANOTHER ONE FELT THAT HE DIDN'T 

17 HAVE TIME TO EVALUATE ALL THE ELEVATORS BECAUSE MOST OF THEM 

18 ARE 20 TO 25 YEARS OLD ELEVATORS. WE ALSO REQUIRED FOR THEM TO 

19 DISPOSE OF ANY WASTE MATERIAL THAT IS EMITTED FROM THE 

20 ELEVATORS. THEY DIDN'T WANT TO BE IN COMPLIANCE WITH THAT 

21 SO... 

22

23 SUP. ANTONOVICH: HOW MUCH IS THIS CONTRACT FOR? 

24
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1 CARLOS JACKSON: IT'S A THREE-YEAR CONTRACT BUT RENEWABLE ON A 

2 YEARLY BASIS. THE FIRST YEAR, I BELIEVE, IS A LITTLE BIT OVER 

3 50,000. LET ME DOUBLE-CHECK ON THIS ONE, SIR. IT'S 52,000 AND 

4 IT GOES TO 43,000. AND THEN A THIRD YEAR. I'M SORRY, THE FIRST 

5 YEAR IS 52,000 AND THEN 53,000 AND THEN THE THIRD YEAR IS 

6 54,000. 

7

8 SUP. ANTONOVICH: AND WHAT DID THE ELEVATOR MAINTENANCE 

9 SERVICES PROVIDE? 

10

11 CARLOS JACKSON: WELL, WE HAVE 36 ELEVATORS AND THEY ARE 

12 PREDOMINANTLY IN ALL OUR SENIOR COMPLEXES AND THEY MAKE SURE 

13 THAT THEY'RE IN OPERATION AND COMPLIANCE WITH THE BILLING CODE 

14 FOR OPERATIONAL. SEVERAL-- MAYBE ABOUT A MONTH AGO, WE CAME 

15 HERE WITH AN EMERGENCY REQUEST TO REPLACE TWO ELEVATORS IN 

16 KINGS ROW, WHICH IS IN THE THIRD DISTRICT. SO THEY MAINTAIN 

17 THE OPERATION OF THE ELEVATORS, THE MAINTENANCE OPERATION OF 

18 THE ELEVATORS. 

19

20 SUP. ANTONOVICH: WHAT I DON'T UNDERSTAND, THEY ENDED UP WITH 

21 ONE BID AND IT JUST SEEMS THAT WE'RE NOT COMMUNICATING, 

22 THERE'S SOME TYPE OF A DISCONNECT FOR THIS TYPE OF A CONTRACT 

23 BECAUSE I WOULD ASSUME THESE VENDORS DO MORE THAN ONE AGENCY. 

24
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1 CARLOS JACKSON: WELL, YOU KNOW, WE-- THAT'S AN ISSUE FOR US AS 

2 WELL OF A CONCERN. HOWEVER, WE HAVE BASICALLY GONE BEYOND WHAT 

3 IS NORMALLY REQUIRED AND WE DID EXTENSIVE OUTREACH BUT THE 

4 HOUSING COMMISSION, THE ADVISORY COMMISSION HAS REQUESTED SOME 

5 TIME AGO, I WOULD SAY AT LEAST 10 YEARS AGO, THAT WE PUBLISH 

6 IT IN NINE DIFFERENT NEWSPAPERS, COMMUNITY NEWSPAPERS, TO GET 

7 A LARGER PARTICIPATION IN THE BIDS. WE HAVE DONE THAT. WE DID 

8 IT IN THE "L.A. TIMES". WE ATTEND MANY OF THE FAIRS, 

9 CONTRACTORS' FAIRS TO PUBLICIZE THE OPPORTUNITIES THAT WE HAVE 

10 FOR CONTRACTING. IT'S A DIFFICULT TIME FOR US BECAUSE WE'RE 

11 COMPETING WITH THE PRIVATE SECTOR, WHO ARE MORE LUCRATIVE AND 

12 LESS PAPERWORK THAN WE REQUIRE. 

13

14 SUP. ANTONOVICH: OKAY. THOSE ARE MY QUESTIONS. IT'S JUST THAT 

15 WE'RE AWARDING A CONTRACT AND WHY OTHERS WEREN'T BIDDING AND 

16 THOSE WHO WOULD ATTEND A PRE-CONFERENCE DON'T SUBMIT BIDS. I 

17 WOULD... 

18

19 CARLOS JACKSON: I MEAN, AS I SAY, WHEN WE DO HAVE ONE BID, WE 

20 TYPICALLY GO BACK AND ASK FOR WHY CONTRACTORS DID NOT BID AND 

21 WAS THERE SOMETHING THAT WE COULD DO DIFFERENTLY. 

22

23 SUP. ANTONOVICH: THANK YOU. DO YOU HAVE ANY QUESTIONS? 

24
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1 SUP. KNABE: NO. WE'RE SORT OF ON A RUN OF THESE THINGS RIGHT 

2 NOW WHERE WE'RE NOT GETTING BIDDERS ON A NUMBER OF DIFFERENT 

3 PROJECTS. I MEAN, THEY DON'T CHARGE US-- I MEAN, I DON'T KNOW 

4 WHAT YOU MEAN TO SAY, THEY'RE MORE LUCRATIVE. THEY DON'T 

5 CHARGE US ANY DIFFERENT THAN THEY WOULD IN THE PRIVATE SECTOR. 

6 THE PROBLEM IS OUR SYSTEM AND THE PROBLEMS ARE SO CUMBERSOME 

7 AND OUR TURNAROUND SOMETIMES AND PAYMENT, JUST NOT WORTH IT, 

8 SO... 

9

10 SUP. ANTONOVICH: MOVE THE ITEM. SECONDED BY BURKE. WITHOUT 

11 OBJECTION, SO ORDERED. ON ITEM 39, I WOULD LIKE TO AMEND IT. 

12 AS WE KNOW, THE PUBLIC SAFETY PROJECT IS CRITICAL BECAUSE OF 

13 THE CURRENT FIRE AND SHERIFF DEPARTMENT'S COMMUNICATIONS 

14 SYSTEMS ARE ANTIQUATED AND THIS CONTRACT WITH THE RCC 

15 CONSULTANTS REQUIRES THE COMPANY TO DEVELOP AND PROVIDE A 

16 TECHNICAL SCOPE OF WORK FOR THE REQUEST FOR PROPOSALS. 

17 HOWEVER, TO ACTUALLY PAY FOR THE COMMUNICATION SYSTEM, WHICH 

18 IS GOING TO BE AN ESTIMATED HALF A BILLION DOLLARS, THE BOARD 

19 NEEDS TO BE ADVISED OF ALTERNATIVE AND CREATIVE FINANCING 

20 OPTIONS. SO I'D MOVE THAT THE BOARD DIRECT THE DIRECTOR OF 

21 INTERNAL SERVICES DEPARTMENT TO WORK JOINTLY WITH THE C.A.O. 

22 IN DEVELOPING A TASK FORCE TO FOCUS ON THE FINANCING ASPECT OF 

23 THE REPLACEMENT ACQUISITION OF THE FIRE SHERIFF COMMUNICATIONS 

24 SYSTEM, INCLUDING BUT NOT LIMITED TO THE DEVELOPMENT OF THE 

25 LANGUAGE FOR INCLUSION IN THE R.F.P. THAT CALLS FOR 
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1 ALTERNATIVE AND FREE THE FINANCING UP OPTIONS WHICH WILL ALSO 

2 BE USED TO EVALUATE THE BIDS AND PROVIDE THE BOARD WITH 

3 QUARTERLY REPORTS ON THIS PROPOSAL. 

4

5 SUP. KNABE: LET ME LOOK AT IT. OKAY. I'LL SECOND. 

6

7 SUP. ANTONOVICH: SECONDED BY KNABE. WITHOUT OBJECTION, SO 

8 ORDERED. SENATOR GIL CEDILLO IS HERE WHO WOULD LIKE TO MAKE A 

9 COMMENT RELATIVE TO THE HOMELESS ISSUE AND THE DUMPING ISSUE 

10 THAT WAS RAISED. WELCOME. HOW ARE YOU? 

11

12 GILBERT CEDILLO: GOOD MORNING, MR. SUPERVISOR AND SUPERVISORS. 

13 I DIDN'T WANT TO LET THE OPPORTUNITY PASS THAT I COULD COME UP 

14 AND SPEAK ENTHUSIASTICALLY IN SUPPORT OF A MOTION BY 

15 SUPERVISOR ANTONOVICH. THAT IN ITSELF WOULD SEEM TO BE 

16 NOTEWORTHY AND NEWSWORTHY. LET ME COMMEND YOU AND THE 

17 SUPERVISORS ON YOUR APPROACH AND OFFER SIMPLY OUR SUPPORT, THE 

18 SUPPORT OF MY OFFICE. I AM WORKING WITH THE SPEAKER. WE ARE 

19 PUTTING FORTH SOME PROPOSALS TO ADDRESS THE SITUATION THAT WE 

20 HAVE AT SKID ROW. AT THIS POINT, WE APPEAR TO HAVE A CONSENSUS 

21 AND WE APPLAUD YOUR MOTION, SUPERVISOR ANTONOVICH. WE MUST, 

22 WHILE THE RESOURCES-- WHILE MANY RESOURCES EXIST DOWNTOWN, 

23 THERE ARE NOT SUFFICIENT RESOURCES TO ADDRESS THE CHALLENGES 

24 THAT CONFRONT A REGION OF 13 MILLION PEOPLE, AND THAT IS 

25 SIMPLY THE FACT OF THE MATTER. AND SO WE MUST END THE THOUGHT 
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1 THAT WE CAN SIMPLY, EVERY CITY, ALL 88 CITIES AND THEN 

2 SURROUNDING COUNTIES AND SURROUNDING STATES SHOULD SEND EVERY 

3 PERSON WHO HAS MENTAL ILLNESS CHALLENGES, AND DRUG AND ALCOHOL 

4 ABUSE CHALLENGE, FINANCIAL CHALLENGE, ET CETERA, SHOULD BE 

5 SENT TO DOWNTOWN LOS ANGELES. THAT IS SIMPLY A STRATEGY AND A 

6 POLICY THAT DOES NOT WORK. WE HAVE BEEN CONVINCED THAT THERE 

7 MAY BE A NEED FOR ENHANCEMENTS FOR PEOPLE WHO PREY UPON THAT 

8 COMMUNITY, PARTICULARLY LARGE DRUG DEALERS, AND WE ARE WORKING 

9 WITH THE SPEAKER TO DEVELOP LEGISLATION THAT WILL CREATE 

10 ENHANCEMENTS WORKING WITH L.A.P.D. ON THIS MATTER. WE ARE 

11 WORKING WITH AND I SPOKE TO THE SHERIFF YESTERDAY ABOUT OUR 

12 EFFORTS TO END THE RELEASE AND THE DUMPING OF PEOPLE. 

13 OBVIOUSLY, WE WANT TO WORK WITH HIM AND FOLLOW HIS LEADERSHIP 

14 ON THIS ISSUE. HE'S INDICATED THAT THAT IS NOT HIS DESIRE. 

15 YESTERDAY, WE WERE FORTUNATE TO MEET WITH JUDGE TYNAN, WHO WE 

16 ALL KNOW HIS PASSION FOR A COMMUNITY COURT AND FOR WORKING 

17 WITH THOSE WHO HAVE MENTAL ILLNESS AND DRUG AND ALCOHOL ABUSE 

18 AND WE ARE COMMITTED TO GOING TO SACRAMENTO TO FIND RESOURCES 

19 TO CREATE A PILOT FOR THE CHALLENGES THAT CONFRONT US IN THE 

20 DOWNTOWN AREA. AND SO I AM HERE SIMPLY BECAUSE I READ OF YOUR 

21 EFFORTS, YOUR MOTION AND WE WANT TO COMMIT THE RESOURCES FROM 

22 OUR OFFICE AND FROM THE STATE AND THE SPEAKER WHO WILL RETURN 

23 TO LOS ANGELES TOMORROW HAS BEEN WORKING WITH US AND OUR 

24 OFFICES ARE WORKING TOGETHER AND WE WANT TO SUPPORT THE COUNTY 

25 IN ITS EFFORTS. CLEARLY, WHAT WE HAVE DONE IN THE PAST IS NOT 
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1 WORKING AND DOES NOT WORK AND, BEFORE WE CAN ADDRESS THE 

2 ISSUES OF HOMELESSNESS AND POVERTY THAT EXIST DOWNTOWN, WE 

3 MUST ELIMINATE THIS OPEN AIR SWAP MEET OF DRUG DEALERS THAT 

4 EXISTS IN THE DOWNTOWN AREA. IT'S JUST INTOLERABLE AND 

5 UNACCEPTABLE AND THAT IS OUR COMMITMENT TO WORK WITH YOU TO 

6 ADDRESS THAT. 

7

8 SUP. ANTONOVICH: GOOD. YOU KNOW, ONE OF THE SERIOUS PROBLEMS 

9 IS TREATING THE MENTALLY ILL HOMELESS AND, WHILE FORMER 

10 ASSEMBLYWOMAN ELLEN THOMPSON WAS ABLE TO MAKE SOME 

11 MODIFICATIONS, THERE IS STILL AN URGENT NEED TO HAVE STATE LAW 

12 TO REQUIRE TREATMENT FOR MENTALLY ILL HOMELESS. IN TALKING 

13 WITH MAYOR VILLARAIGOSA, HE'S ALSO SUPPORTIVE NOW OF TREATMENT 

14 FOR THESE INDIVIDUALS. SO HOPEFULLY WE CAN GET A BIPARTISAN 

15 EFFORT TO CHANGE THE ACT TO LANDERMAN PETRO SCHWART ACT ENSURE 

16 THAT MENTALLY ILL PEOPLE RECEIVE THE TREATMENT INSTEAD OF 

17 REFUSING IT AND STAYING ON THE CURB OR... 

18

19 GILBERT CEDILLO: WELL, THAT'S GOING TO BE THE-- YOU KNOW, FOR 

20 ALL OF US, THAT'S GOING TO BE THE REAL RUB, THE LARGER 

21 DISCUSSION. AS YOU KNOW, ASSEMBLYWOMAN HELEN THOMPSON PLAYED A 

22 REAL LEADERSHIP ROLE IN THE STATE. WE HAD A TWO-YEAR 

23 DISCUSSION SIMPLY ON THAT POINT UP AND DOWN THE STATE BUT THE 

24 DISCUSSION AND THE WILLINGNESS TO CHANGE AT THAT POINT DID NOT 

25 EXIST BUT WE ARE LOOKING AT A MOMENT, I THINK, SUPERVISOR, 
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1 THAT THERE MAY BE A GREATER OPENNESS. OBVIOUSLY, THE MAYOR HAS 

2 BEEN HELPFUL IN BEING OUTSPOKEN ON THIS. HIS STRONG TIES TO 

3 THE A.C.L.U., MY STRONG TIES TO THE A.C.L.U., MANY OF OURS. 

4 YOU KNOW, WE DO NOT COME TO THIS POINT EASILY BUT WE DO 

5 RECOGNIZE THAT WE ARE CONFRONTED WITH A VERY DRAMATIC 

6 SITUATION THAT WILL REQUIRE PARADIGM SHIFTS FOR MANY OF US IN 

7 OUR THINKING ON HOW WE HANDLE THIS. WE ARE SEARCHING FOR THE 

8 BALANCE, FOR SOMEONE LIKE MYSELF TO COME AND BE PREPARED TO 

9 SUPPORT AND TO INTRODUCE ENHANCEMENTS. IT'S A LONG JOURNEY BUT 

10 IT IS DICTATED BY THE DEMANDS OF THE SITUATION AND WE HOPE 

11 THAT WE CAN DO SO... 

12

13 SUP. ANTONOVICH: AND OUR OFFICE WILL WORK WITH YOU ON THAT. 

14

15 GILBERT CEDILLO: WE APPRECIATE IT. 

16

17 SUP. ANTONOVICH: AND I KNOW HELEN THOMPSON, SHE'S NOW A 

18 SUPERVISOR, WILL ALSO WORK WITH YOU BECAUSE SHE WAS HERE A 

19 NUMBER OF TIMES AND WORKED WITH OUR BOARD AND OUR COMMUNITY 

20 AND I WAS WITH HER AND JOINED ME IN A PUBLIC HEARING ON THIS 

21 ISSUE. SO WE'RE WILLING TO HELP, GIL, AND LOOK FORWARD TO 

22 DOING THAT. 

23

24 SUP. BURKE: MR. CHAIRMAN? 

25
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1 SUP. ANTONOVICH: SUPERVISOR BURKE. 

2

3 SUP. BURKE: YES. I WAS IN THE LEGISLATURE WHEN THAT PASSED. 

4 THE THING THAT WAS MISSING IS THAT THE REPRESENTATION MADE TO 

5 THE LEGISLATURE AT THAT TIME WAS THAT THERE WOULD BE COMMUNITY 

6 FACILITIES THAT WOULD ADEQUATELY PROVIDE FOR ALL OF THOSE 

7 PEOPLE WHO WERE RELEASED FROM STATE INSTITUTIONS OR WHO WERE 

8 NOT BEING HELD UNLESS THEY WERE A DANGER TO THEMSELVES OR TO 

9 OTHERS. THOSE COMMUNITY FACILITIES NEVER CAME ABOUT. ALSO, 

10 THERE WAS NEVER ANY MECHANISM TO MAKE SURE THAT PEOPLE 

11 UTILIZED THE COMMUNITY FACILITIES AND, AS MANY OF US TALK TO 

12 PEOPLE WHO PROVIDE SERVICES IN SKID ROW AND OTHER SERVICES FOR 

13 THE HOMELESS, THEY FIND OFTEN THAT, IF THEY REQUIRE THAT THE 

14 PERSON TAKE MEDICATION OR IF THEY REQUIRE THAT THE PERSON BE 

15 DRUG-FREE TO REMAIN IN A FACILITY, MANY PEOPLE IN SKID ROW OR 

16 PEOPLE WHO ARE HOMELESS WILL NOT REMAIN IN THOSE FACILITIES. 

17 SO IT'S A VERY DIFFICULT ISSUE AND IT'S PROBABLY ONE OF THE 

18 FEW PLACES WHERE THE A.C.L.U. AND REAGAN, OUR FORMER PRESIDENT 

19 AND FORMER GOVERNOR, CAME TOGETHER IN PUSHING FORWARD THIS 

20 APPROACH TO THOSE ISSUES OF MENTAL ILLNESS. BUT THE REACTION 

21 TO WHAT'S HAPPENED FROM THAT LEGISLATION HAS NOT BEEN 

22 POSITIVE. SO IT'S DIFFICULT BUT I DO THINK THAT WE ARE GOING 

23 TO HAVE TO ESTABLISH SOME METHOD OF ASSURING THAT PEOPLE WHO 

24 NEED HELP GET HELP. 

25
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1 GILBERT CEDILLO: RIGHT, ONE OF THE THINGS IS THAT-- I MEAN, 

2 YOU'RE ABSOLUTELY RIGHT AND THAT WAS THE RUB OF THE ENTIRE 

3 DISCUSSION WHEN HELEN THOMPSON WAS-- WE WERE ALL PART OF THIS 

4 SPECIAL COMMITTEE. WE HAVE TO FIGURE OUT SOME WAY TO HAVE SOME 

5 CONTINUITY OF CARE. WE MAKE AN INVESTMENT, SAY THE SHERIFF IS 

6 DOING 18 MONTHS OF MENTAL HEALTH TREATMENT, THEN WE DON'T HAVE 

7 A FOLLOW-UP PLAN, A CONTINUITY OF CARE AND SO THAT INVESTMENT 

8 IS LOST TWO WEEKS LATER. I MEAN, WHAT WE'RE SEEING, THE SAME 

9 THING WHEN-- I MEAN, THE CHALLENGES FOR PEOPLE WHO ARE IN 

10 RECOVERY, MAKING SINCERE EFFORTS IN RECOVERY AND THEN FOR THEM 

11 TO COME OUT, IF WE DON'T HAVE THAT FOLLOW-UP, THAT 

12 INFRASTRUCTURE, THOSE SYSTEMS IN PLACE, THEN, YOU KNOW, WE'RE 

13 UNDERMINING THE INVESTMENT THAT WE'VE MADE TO HELP PEOPLE 

14 EITHER DEAL WITH THEIR MENTAL ILLNESS OR TO DEAL WITH THE 

15 ISSUES WITH DRUG AND ALCOHOL ABUSE. 

16

17 SUP. BURKE: WE'RE ALL INTERESTED IN TRYING TO MOVE IN THAT 

18 DIRECTION AND TO FIND SOME SOLUTION. 

19

20 GILBERT CEDILLO: WELL, SPEAKING ON BEHALF OF OUR OFFICE, YOU 

21 CAN COUNT ON OUR SUPPORT. 

22

23 SUP. ANTONOVICH: THANK YOU VERY MUCH. 

24

25 GILBERT CEDILLO: THANK YOU VERY MUCH. 
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1

2 SUP. BURKE: THANK YOU FOR BEING HERE. 

3

4 SUP. ANTONOVICH: OKAY. THOSE-- SUPERVISOR BURKE? 

5

6 SUP. BURKE: I MOVE THAT, WHEN WE ADJOURN TODAY, WE ADJOURN IN 

7 MEMORY OF URSULA JACQUELINE, "JACKIE" BROUSSARD. SHE PASSED 

8 AWAY NOVEMBER 14TH, 2005. SHE WAS A NATIVE LOS ANGELES, WAS A 

9 PRODUCT OF L.A.U.S.D. SCHOOLS. SHE ATTENDED AND RECEIVED HER 

10 DOCTORATE FROM U.S.C. SHE WAS A TALENTED MUSIC SUPERVISOR, 

11 PRESIDENT OF THE SOUTHEAST SYMPHONY FOR APPROXIMATELY 20 

12 YEARS. SHE WAS THE INITIATOR OF THE SOUTHEAST SYMPHONY 

13 CONSERVATORY, WHICH NOW SERVICES 200 CHILDREN IN A COMMUNITY-

14 BASED INSTRUMENTAL INSTRUCTION PROGRAM. SHE WAS A FORMER CHOIR 

15 DIRECTOR AND A LONG-TIME MEMBER OF FOUNDERS CHURCH, LOCATED AT 

16 6 AND BARENDO. SHE IS SURVIVED BY HER HUSBAND OF OVER 50 

17 YEARS, CHARLES, TWO DAUGHTERS, DENISE ORSO AND KIM STEWART, 

18 AND ONE SON, CRAIG BROUSSARD, AND SEVEN GRANDCHILDREN AND ONE 

19 GREAT- GRANDCHILD. I KNOW THAT I SPOKE TO HER JUST SHORTLY 

20 BEFORE HER DEATH WHEN SHE WAS VERY CONCERNED ABOUT HER 

21 DAUGHTER, WHO WAS RETURNING TO VIETNAM-- TO IRAQ AND WHO HAD 

22 BEEN IN THE SERVICE BUT WHO WAS INTERESTED IN PURSUING A 

23 MEDICAL CAREER AND SO SHE'LL BE SORELY MISSED. AND THOMAS 

24 CLAYTON, WHO PASSED AWAY LAST WEEK. HE WAS A RESIDENT OF THE 

25 CITY OF CARSON FOR MORE THAN 42 YEARS. HE WAS ONE OF THE FIRST 
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1 AFRICAN-AMERICANS TO SERVE IN THE U.S. MARINE CORPS IN WORLD 

2 WAR II. HE WAS VERY ACTIVE IN CIVIC AFFAIRS AND HE SERVED AS A 

3 COMMISSIONER FOR THE CITY OF CARSON. AS A LIFELONG TRACK AND 

4 FIELD ATHLETE, HE COMPETED WELL INTO HIS SENIOR YEARS. MR. 

5 CLAYTON IS SURVIVED BY HIS WIFE OF 57 YEARS, KATHERINE, THREE 

6 DAUGHTERS, SHARON, KELLY, AND KATHERINE, JUNIOR, AND HE WILL 

7 BE MISSED BY HIS FAMILY AND FRIENDS. DR. ELLA GRACE PAYNE, A 

8 LONG-TIME RESIDENT OF THE SECOND DISTRICT AND OUTSTANDING 

9 MEMBER OF THE COMMUNITY. SHE SERVED AS DIRECTOR OF WESTMINSTER 

10 ASSOCIATION IN WATTS, WHICH WAS A PRESBYTERIAN CENTER THAT 

11 PROVIDED COMMUNITY SERVICES FOR MANY, MANY YEARS, AND SHE IS 

12 SURVIVED BY HER SON, THOMAS PANE. SHE WAS VERY ACTIVE 

13 THROUGHOUT LOS ANGELES, NOT JUST IN THE WATTS COMMUNITY, OVER 

14 THE YEARS, AND SHE'LL BE SORELY MISSED. AND RUTH MICHAUD, WHO 

15 PASSED AWAY ON NOVEMBER 22ND AT THE AGE OF 86 IN HAMMOND, 

16 CALIFORNIA. SHE WAS THE MOTHER-IN-LAW OF DAVID FLINT, 

17 ASSISTANT DIRECTOR OF THE PUBLIC LIBRARY. MRS. MICHAUD IS 

18 SURVIVED BY A BROTHER, FOUR SISTERS, FOUR DAUGHTERS, SEVEN 

19 GRANDCHILDREN AND 12 GREAT-GRANDCHILDREN. AND MARY ALATORRE, 

20 WHO PASSED AWAY SATURDAY, NOVEMBER 26TH. SHE WAS BORN JULY 

21 1ST, 1917. SHE WAS A LIFELONG RESIDENT OF BOYLE HEIGHTS AND 

22 WAS MARRIED TO JOEL ALATORRE, THE LOVE OF HER LIFE, FOR 25 

23 YEARS. SHE WAS RICHARD'S NUMBER 1 SUPPORTER, ALWAYS THE FIRST 

24 TO VOLUNTEER AT HIS CAMPAIGNS. SHE NEVER MISSED A SINGLE ONE. 

25 SHE IS SURVIVED BY TWO CHILDREN, RICHARD AND CECILIA ALATORRE, 
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1 AND FIVE GRANDCHILDREN, DEREK, DARRELL, AMANDA, RYAN AND 

2 MELINDA AND THREE GREAT-GRANDCHILDREN, GABRIELA, MARYELLA AND 

3 DANIELA. 

4

5 SUP. KNABE: I WANT TO BE ADDED. 

6

7 SUP. BURKE: AND SUPERVISOR MOLINA IS JOINING ME AS A JOINT. 

8

9 SUP. YAROSLAVSKY: PUT ALL MEMBERS. 

10

11 SUP. ANTONOVICH: ALL MEMBERS. 

12

13 SUP. BURKE: ALL MEMBERS. AND I THINK HER MEMORIAL IS ON 

14 WEDNESDAY MORNING. DAVID KAHANE, WHO PASSED AWAY SUDDENLY 

15 SUNDAY EVENING AT AGE 90. HE WAS THE BELOVED FATHER OF FRED 

16 KAHANE AND WHO IS WITH LINK HOUSING. THAT CONCLUDES MY 

17 ADJOURNMENTS. 

18

19 SUP. ANTONOVICH: SECONDED. WITHOUT OBJECTION, SO ORDERED. DR. 

20 CLAVREUL? DOES SUPERVISOR MOLINA HAVE ANY ADJOURNMENT MOTIONS? 

21 OKAY. IF NOT, LET ME CALL UP PUBLIC COMMENT. LARRY ROSS AND 

22 KAREN OCAMB. LARRY ROSS? 

23

24 KAREN OCAMB: SHOULD I GO FIRST? HI. MY NAME IS KAREN OCAMB AND 

25 I AM THE NEWS EDITOR FOR IN LOS ANGELES MAGAZINE AND A 
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1 SUNSHINE ADVOCATE. I WANT TO REFER TO ITEM 72. GIVEN THE 

2 PREVENTABLE DEATH OF TWO-YEAR-OLD SARA CHAVEZ IN OCTOBER, I'M 

3 CONCERNED THAT YOUR CORRECTIVE PLAN OF ACTION WILL BE 

4 CONCEIVED IN THE SHADOWS AND, IN THIS CASE, THE PUBLIC WILL BE 

5 KEPT IN THE DARK ABOUT HOW D.C.F.S. WILL CORRECT THIS 

6 CONTINUED SYSTEMATIC ABUSE. ADDITIONALLY, I URGE FULL 

7 DISCLOSURE OF WHAT WENT SO TRAGICALLY WRONG IN THE SARA CHAVEZ 

8 CASE. I SUSPECT COUNTY COUNSEL WILL OPPOSE RELEASING THE 

9 D.C.F.S. O.I.R. REPORT, DESPITE SUPERVISOR MOLINA'S PLEDGE TO 

10 DO SO, CITING ISSUES OF CONFIDENTIALITY. BUT, AS CALIFORNIANS 

11 AWARE GENERAL COUNSEL, TERRY FRANK, NOTED IN A LETTER TO OUR 

12 MAGAZINE, "THE STATED CONCERN FOR THE CHILDREN'S PRIVACY IS A 

13 CRUEL, PERHAPS EVEN CYNICAL SHIELD FOR INTOLERABLE NEGLECT. 

14 POSTMORTEM USED TO DENOTE A SEARCHING EXAMINATION OF WHAT 

15 CAUSED A DEATH, RESULTING IN A PUBLIC REPORT THAT WOULD HELP 

16 REDUCE AVOIDABLE RISKS IN THE FUTURE. NOW, INSTEAD OF A 

17 CORRECTIVE-- A CONSTRUCTIVE UNCOVERING OF THE FACTS, WE ARE 

18 LEFT WITH WHAT CAN ONLY BE THOUGHT OF AS THEIR COVER-UP." THE 

19 D.C.F.S. O.I.R. REPORT SHOULD EXPLAIN, NUMBER 1, WHY THE 

20 CHILD'S ATTORNEY REMOVED SARA FROM HER LOVING FOSTER FAMILY IN 

21 THE FIRST PLACE. THE GAY COMMUNITY IN PARTICULAR IS INTERESTED 

22 TO SEE IF BIAS PLAYED ANY ROLE HERE. TWO, WHETHER D.C.F.S. 

23 ARGUED AGAINST THE REMOVAL AND, IF SO, HOW STRENUOUSLY. THREE, 

24 WHAT SUPERVISION D.C.F.S. PROVIDED DURING THE FIVE MONTHS FROM 

25 THE REMOVAL TO SARA'S DEATH. IT'S BEEN 10 YEARS SINCE 2-1/2-
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1 YEAR-OLD LANCE HELMS DIED IN A SIMILAR FASHION. A SUBSEQUENT 

2 STATE AUDIT OF D.C.F.S. SUGGESTED A SYSTEM OVERHAUL. DID THAT 

3 HAPPEN? IF SO, WHAT WENT WRONG AND WHY? RELEASING THE D.C.F.S. 

4 O.I.R. REPORT COULD AT LEAST BE A FIRST STEP IN CORRECTING 

5 SUCH TRAGIC SYSTEMATIC PROBLEMS. THANK YOU VERY MUCH. 

6

7 SUP. ANTONOVICH: THANK YOU. WELCOME BACK, MR. ROSS. IT'S BEEN 

8 AWHILE. GOOD TO SEE YOU. 

9

10 LARRY ROSS: YEAH, IT'S BEEN A WHILE. THANK YOU VERY MUCH. MY 

11 NAME IS LARRY ROSS. WHAT I WILL SAY TODAY BEFORE THE COUNTY 

12 BOARD OF SUPERVISORS OF THE COUNTY OF LOS ANGELES WON'T BE 

13 ANYTHING NEW FOR I HAVE BEEN REPORTING THE ABUSES AGAINST MY 

14 SON'S FAMILY AND I SINCE THE EARLY '90S BUT I HAVE SEEN THE 

15 NEED TO COME BACK TODAY TO CONTINUE FROM WHERE I LEFT OFF IN 

16 NOVEMBER 2004, TO INFORM THE BOARD OF SUPERVISORS OF LOS 

17 ANGELES COUNTY THE CONSTITUTIONAL ABUSES HAVE CONTINUED 

18 WITHOUT LET UP, WITH NOTICEABLE FLUCTUATIONS FROM TIME TO 

19 TIME. LET ME BEGIN IN 1986, WHERE I OVERHEARD MY SUPERVISOR 

20 TALKING ON THE PHONE ABOUT MARITAL PROBLEMS. I WAS ALLEGEDLY 

21 ENGROSSED IN THAT. AND EARLIER OR MAYBE LATER, I MAY HAVE 

22 HEARD ANOTHER SUPERVISOR WAS OVERHEARD ON THE PHONE EXPRESSING 

23 HOW HE WAS HAPPY IN HIS MARRIAGE. IN 1987, A FEDERAL AGENCY 

24 BEGAN TO BE CONTACTED CONCERNING THE ABUSES SUBJECTED. IN 

25 1991, A LAWSUIT WAS INITIATED AGAINST ABOUT EIGHT DEFENDANTS, 
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1 AT LEAST 5 TO 6 WERE COUNTY FACILITIES. IN 1992, I BEGAN 

2 COMING TO THE BOARD OF SUPERVISORS MEETINGS. IN 1993, I BEGAN 

3 PARTICIPATING, BY TELLING THE BOARD OF THE WRONGS BEING DONE. 

4 AND I KEPT IT UP REGULARLY. EVERY CHANCE I GOT, I WOULD 

5 EXPRESS, EXPOSE THE WRONGS. IN 1993 WAS MY SECOND FALSE 

6 IMPRISONMENT BASED ON LIES. THEN MY THIRD FALSE IMPRISONMENT 

7 OCCURRED IN APRIL 1994 THROUGH JUNE 1ST OF 1994. I WAS 

8 SUBJECTED THERE TO A BOGUS PROCEEDING IN 1995. THEN, 1996, 

9 FALSELY IMPRISONED FOR NEARLY 60 DAYS. IN 1998, FALSELY 

10 IMPRISONED FOR 7-1/2 MONTHS. ALL OF THE ABOVE STEMMED FROM 

11 GROSS VIOLATIONS OF MY CONSTITUTIONAL AND CIVIL RIGHTS. ALL 

12 THE ABUSES WERE REPORTED AT BEFORE THIS BOARD, ALONG WITH MANY 

13 OTHER VIOLATIONS AGAINST MY PERSON AND PROPERTY. IN 2002, 

14 INTERFERENCES WITH MY RIGHTS TO MOVE FREELY WITHIN THE BORDERS 

15 OF THIS NATION CAME UNDER ATTACK. SAME YEAR, UNSUSPECTED 

16 DEATHS OF FAMILY MEMBERS BEGAN. IN 2003, I WAS THE VICTIM OF 

17 AN ASSAULT AND BATTERY BUT I HAD TO STAND AT TRIAL AS THE 

18 DEFENDANT BEFORE A KANGAROO COURT. IN 2004, THE BOARD WAS 

19 BROUGHT UP TO DATE. SO TODAY I AM HERE INFORMING THE BOARD OF 

20 SUPERVISORS THE ABUSES ARE CONTINUING, WITH THE ALARMING-- 

21 WITH AN ALARMING REGULARITY AND OBVIOUSNESS. THE PERPETRATORS 

22 DON'T HAVE A LEGAL LEG TO STAND ON AND THE ONLY OFFICIAL 

23 MANUFACTURED ONE IS DEFECTIVE. THEREFORE, ACCORDING TO 

24 TRANSMISSIONS, THEIR WEAK DEFENSE WILL BE, HE DOESN'T KNOW 

25 ENOUGH OR IT HAS BEEN TOO LONG OR HE WAITED TOO LONG. THAT 
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1 WINDS UP WHAT I HAVE TO SAY. I DO APPRECIATE THE BOARD FOR 

2 ALLOWING ME THE OPPORTUNITY TO COMPLETE WHAT I CAME HERE TO 

3 SAY. THANK YOU. 

4

5 SUP. ANTONOVICH: THANK YOU, MR. ROSS. EXECUTIVE OFFICE. 

6

7 CLERK ROBIN GUERRERO: IN ACCORDANCE WITH BROWN ACT 

8 REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF 

9 SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEM CS-

10 1, CONSIDERATION, CONFERENCE WITH LEGAL COUNSEL REGARDING 

11 EXISTING LITIGATION AS INDICATED ON THE POSTED AGENDA. 

12

13

14

15

16

17

18

19

20

21

22

23

24

25
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1 REPORT OF ACTION TAKEN IN CLOSED SESSION ON NOVEMBER 29, 2005 

2

3

4

5 The Board of Supervisors met today in Closed Session. The 

6 following action is being reported: 

7

8 CS-1. CONFERENCE WITH LEGAL COUNSEL - EXISTING LITIGATION 

9 (Subdivision (a) of Government Code Section 54956.9) Deborah 

10 Miles, et al. v. County of Los Angeles, et al., U.S. District 

11 Court Case No. CV 02-03932 DT  

12

13 This is a class action lawsuit in which plaintiffs contend 

14 that the County and the Superior Court have failed to provide 

15 physical access to County courthouses for persons with 

16 mobility and manual dexterity disabilities. 

17

18 Action Taken: 

19

20 The Board authorized settlement of the above lawsuit. The 

21 substance of the settlement will be disclosed upon inquiry by 

22 any person as soon as the settlement becomes final following 

23 approval by all parties. The vote of the Board of Supervisors 

24 was unanimous, with Supervisor Molina being absent.

25
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1     I, JENNIFER A. HINES, Certified Shorthand Reporter 

2     Number 6029/RPR/CRR qualified in and for the State of 

3 California, do hereby certify:

4        That the transcripts of proceedings recorded by the 

5 Los Angeles County Board of Supervisors November 29, 2005

6       were thereafter transcribed into typewriting under my 

7 direction and supervision;

8         That the transcript of recorded proceedings as 

9 archived in the office of the reporter and which 

10      have been provided to the Los Angeles County Board of 

11 Supervisors as certified by me.

12         I further certify that I am neither counsel for, nor 

13 related to any party to the said action; nor

14       in anywise interested in the outcome thereof.

15      IN WITNESS WHEREOF, I have hereunto set my hand this 1st 

16 day of December 2005, for the County records to be used only 

17 for authentication purposes of duly certified transcripts      

18 as on file of the office of the reporter.

19   

20                    JENNIFER A. HINES 

21              CSR No. 6029/RPR/CRR
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